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Problem description:
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Error messages and log files
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Information about the Symantec Buying Programs

■

Advice about Symantec's technical support options

■
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■

Issues that are related to CD-ROMs or manuals

Documentation feedback
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on the second page), and chapter and section titles of the text on which you are
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Chapter

1

Introducing the Veritas
High Availability Agent for
SAP NetWeaver
This chapter includes the following topics:
■

About the High Availability agent for SAP NetWeaver

■

What’s new in this release

■

Supported software

■

How the agent makes SAP NetWeaver highly available

■

Agent functions

■

Typical SAP server configuration in a VCS cluster

■

Setting up SAP NetWeaver in a VCS cluster

About the High Availability agent for SAP NetWeaver
The Veritas High Availability agents monitor specific resources within an
enterprise application, determine the status of these resources, and start or stop
them according to external events.
The Veritas agent for SAP NetWeaver provides high availability for SAP R/3 and
SAP NetWeaver in a clustered environment.
It is designed to support a wide range of SAP environments, including the
traditional basis architecture and the SAP J2EE Web Application server
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architecture (NetWeaver). The agent also support Standalone Enqueue and
Enqueue Replication servers in a distributed SAP installation.
The agent for SAP NetWeaver brings SAP instances online, monitors the instances,
and bring the instances offline. The agent monitors the system processes and
server states, and can shut down the instance in case of a failure.
The agent for SAP NetWeaver supports the following SAP instance types:
■

Central instance

■

Dialog instance

■

Standalone Enqueue server

■

Enqueue Replication server

See the following Technical Support TechNote for the latest updates or software
issues for this agent:
http://seer.entsupport.symantec.com/docs/282004.htm

What’s new in this release
The enhancements in this release of the agent for SAP NetWeaver are as follows:
■

Added support for Gateway, Internet Graphics Server (IGS) and Internet
Communication Manager (ICM) processes.

Supported software
The Veritas agent for SAP NetWeaver is supported in the following environments:
Veritas Cluster Server

VCS 5.0, 5.1, 5.1SP1

Note: In the software disc, no separate agent is provided for
VCS 5.1 and 5.1SP1. For VCS 5.1 and 5.1SP1 use the agent
provided for VCS 5.0
Operating Systems

SAP R/3

■

Microsoft Windows Server 2003 (x64)

■

Microsoft Windows Server 2003 (IA64)

■

Microsoft Windows Server 2008 (x64)

4.6C with a 4.6D Kernel
4.6D
4.7 Enterprise Version

SAP Web AS

6.20, 6.40, 7.00

Introducing the Veritas High Availability Agent for SAP NetWeaver
Supported software

SAP NetWeaver

04, 04s

mySAP Business Suite

Based on SAP NetWeaver Platform

SAP applications

Applications Based on SAP NetWeaver platform

Note: All Enhancement Packages (EhPx) for ERP, CRM, SCM,
SRM and SAP NetWeaver based on SAP Kernel 7.00 are
supported.

SAP NetWeaver components compatibility matrix
Table 1-1 lists the compatibility matrix for SAP NetWeaver technology
components.
Compatibility matrix for SAP NetWeaver technology components

Table 1-1
EP

BW

XI

MDM

SAP
Kernel/SAP
Web AS

BI

PI

MDS

7.0

7.0

7.0

5.5, 7.1

7.00

-

-

-

2.0

6.40

6.0

3.5

3.0

-

6.40
6.20

-

3.1

-

-

6.20

Table 1-2 lists the compatibility matrix for SAP NetWeaver application
components.
Compatibility matrix for SAP NetWeaver application components

Table 1-2
R/3 and SCM
R/3
APO
Enterprise
ECC

SRM

6.0 (ERP
2005)

5.0

5.0

5.1 (SCM
2007)

6.0 (SRM
2007)

7.0

7.0

6.0 EhPx

CRM

KW

Solution
Manger

-

7.0 (formerly 7.00
4.0)

EBP

5.0 (CRM
2005)
CRM 2007
7.0

7.0 EhPx

SAP
Kernel/SAP
Web AS
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Compatibility matrix for SAP NetWeaver application components
(continued)

Table 1-2

R/3 and SCM
R/3
APO
Enterprise
ECC

SRM

5.0 (ERP
2004)

4.0 SR1

4.1

CRM

KW

Solution
Manger

SAP
Kernel/SAP
Web AS

7.0

3.20

6.40

EBP

4.0

6.20

4.7x200
4.7x110

4.0

4.0

3.0

-

3.10

6.20

-

-

-

4.6D

3.1
4.6C

3.1

-

How the agent makes SAP NetWeaver highly available
The Veritas agent for SAP NetWeaver continuously monitors the SAP instance
processes to verify that they function properly.
The agent provides the following levels of application monitoring:
■

Primary or Basic monitoring
This mode has Process check and Health check monitoring options. With the
default Process check option, the agent verifies that the SAP instance processes
are present in the process table. Process check cannot detect whether processes
are in hung or stopped states.

■

Secondary or Detail monitoring
In this mode, the agent runs a utility to verify the status of SAP instance. The
agent detects application failure if the monitoring routine reports an improper
function of the SAP instance processes. When this application failure occurs,
the SAP instance service group fails over to another node in the cluster.
Thus, the agent ensures high availability for SAP instance.

Agent functions
The agent consists of resource type declarations and agent executables. The agent
executables are organized into online, offline, monitor, and clean functions.

Introducing the Veritas High Availability Agent for SAP NetWeaver
Agent functions

Online
The online function performs the following tasks:
■

Validates the values of the agent attributes required to bring the SAP instance
online.

■

Performs a preliminary check to ensure that the SAP instance is not running
already on the specified node in the cluster.

■

Starts the SAP Windows service SAPSAPSID_InstID, where InstID is the last
two characters of the InstName attribute.

■

Starts the SAP instance using the startsap.exe utility.

■

Ensures that the instance is initialized successfully.

Offline
The offline function performs the following tasks:
■

Validates the values of the agent attributes required to bring the SAP instance
offline.

■

Performs a preliminary check to ensure that the SAP instance is not already
offline.

■

Stops the SAP instance using the stopsap.exe utility.

■

Stops the SAP Windows service. SAPSAPSID_InstID, where InstID is the last
two characters of the InstName attribute.

■

Kills any remaining SAP instance processes to ensure that the instance
processes are removed completely.

Monitor
The monitor function performs the following tasks:
■

Validates the values of the agent attributes required to monitor the SAP
instance.

■

Performs a first-level monitor check as follows:

■

■

The function verifies that the SAP Windows service SAPSAPSID_InstID is
running, where InstID is the last two characters of the InstName attribute.

■

Verifies that all processes that the ProcMon attribute lists are running.

If the value of SecondLevelMonitor attribute is greater than 0, the monitor
function performs a more thorough check of the SAP instance as follows:
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■

■

For an ABAP Central or Dialog instance, the function uses the sapinfo.exe
utility.
To use second-level monitoring for the ABAP configuration, download the
rfcsdk file for the sapinfo.exe utility. Unzip this file and place the contents
on shared storage that is accessible by all the nodes in the cluster.

■

For a Java Central or Dialog instance, the function uses the jcmon.exe utility.

■

For an Enqueue or Enqueue Replication server instance, the function uses
the ensmon.exe utility.

If the MonitorProgram attribute specifies a custom monitor program, the
monitor function executes the specified program.
See “Executing a custom monitor program” on page 90.

Clean
In case of a fault event or an unsuccessful attempt to bring a resource online or
offline, the clean function removes any remaining SAP instance processes. The
clean function performs the following tasks:
■

Uses SAP’s sapsrvkill.exe utility to stop all processes of the particular SAP
instance.

■

Stops SAPSAPSID_InstID, the SAP Windows service for the instance.

■

The clean function identifies and kills any remaining SAP instance processes
using the unique combination of the SAPSID attribute and InstID, that is the
last two characters of the InstName attribute. All these processes must also
belong to the SAPServiceSAPSID or sapsidadm user.

Typical SAP server configuration in a VCS cluster
A typical SAP server configuration in a VCS cluster has the following
characteristics:
■

VCS is installed and configured in a two-node cluster.

■

The SAP NetWeaver instance binaries are installed locally on both nodes or
on shared disks.

■

The Veritas agent for SAP NetWeaver is installed on the both nodes.

■

The drive:\usr\sap directory is shared with name sapmnt.

Introducing the Veritas High Availability Agent for SAP NetWeaver
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Figure 1-1

depicts a configuration where SAP server instance binaries and SYS
are installed completely on shared disks.
Node 2

Node 1
VCS Private Network

Shared disks / diskgroups

SAP instance binaries and
SYS on shared disks

Public Network
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Figure 1-2

depicts a configuration where SAP server instance binaries are
installed locally on each node and SYS is installed on shared disks.

Node 1

Node 2
VCS Private Network

SAP instance binaries

Shared disks / diskgroups
SAP instance binaries

SYS on shared disks

Public Network

Setting up SAP NetWeaver in a VCS cluster
Follow the steps below to set up SAP NetWeaver in a cluster:
■

Set up a VCS cluster.
Refer to Veritas Storage Foundation™ and High Availability Solutions
Installation and Upgrade Guide for more information on installing and
configuring VCS.

■

Install and configure SAP NetWeaver for High Availability.

■

Install the Veritas High Availability agent for SAP NetWeaver.
See “Installing the VCS agent for SAP NetWeaver” on page 77.

■

Configure the service groups for SAP NetWeaver.
See “About configuring service groups for SAP NetWeaver” on page 93.

Chapter

2

Installing and configuring
the SAP NetWeaver for high
availability
This chapter includes the following topics:
■

About SAP NetWeaver

■

Uniquely identifying SAP server instances

■

Monitoring an SAP instance

■

About installing SAP NetWeaver for high availability

■

About configuring SAP NetWeaver for high availability

■

Setting up SAP systems for clustering

■

Setting up a pre-installed SAP R/3 system

■

Fresh SAP installation: Installing an SAP ABAP system

■

Fresh SAP installation: Installing an SAP Java system

■

Fresh SAP installation: Installing a Java Add-In system (ABAP + Java)

■

Installing an SAP Enqueue Replication server

■

Clustering an SAP instance

■

Creating and adding domain groups and users

■

Creating and adding local groups and users

■

Creating sapmnt and saploc share directories
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■

Configuring the SAP systems on Windows Server 2008

About SAP NetWeaver
All SAP NetWeaver components (example, BI, XI, EP ) run on top of the SAP
NetWeaver Application Server.
The following SAP system installations are possible with SAP NetWeaver
Application Server (AS):
■

SAP NetWeaver Application Server ABAP (ABAP only)

■

SAP NetWeaver AS Java (Java only)

■

SAP NetWeaver Application Server Add-In (ABAP and Java)

Depending on the SAP NetWeaver component to be installed, the Web Application
Server type is determined. For example, SAP NetWeaver EP 6.0 requires a Java
stack, hence SAP NetWeaver AS Java (or Add-In) needs to be installed. SAP
NetWeaver XI 3.0 requires SAP NetWeaver AS Add-In.

SAP system components
An SAP application instance has multiple services or components which are
typically deployed across multiple servers.
SAP identifies the following services as critical to the application environment,
representing potential single points of failure:
■

Database Instance

■

Central Instance (DVEBMGSxx or JCxx)

■

Central Services Instance (SCSxx or ASCSxx)

■

Enqueue Replication Server (ERSxx)

■

Dialog Instance (Dxx or Jxx)

■

Windows sapmnt/saploc shares

Where xx takes the value of an SAP Instance number ranging from 00 to 99.

SAP architecture
Table 2-1 lists the different SAP architectures and its components.
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Table 2-1

SAP architecture

Architecture

Component

Service

Functions

SAP NetWeaver AS
ABAP

Central Instance

ABAP Dispatcher

■

Dialog Instance

Controls program that manages the
resources of the R/3 applications.
■ Balances assignment of the transaction
load to the work processes.
■ Manages buffers in main memory.
Manages connections with the
presentation level.
■ Organizes the communication processes.
■

Central Services
Instance

SAP NetWeaver AS
Java

ABAP Work
processes

■

Acts as a service offered by a server and
requested by a client
■ Acts as a special program in charge of
some specific tasks.

ABAP Enqueue
Service

■

Manages logical locks.

■

Ensures server synchronization.

ABAP Message
Service

■

Central service for cluster internal
communication, such as event
notifications, broadcasts, exchange of
cache content, and so on.
■ Provides cluster state information to SAP
Web Dispatcher.
■ Keeps a list of application servers that can
be reached within the system.

Enqueue Replication ABAP Enqueue
Instance
Replication Service

Enables the lock table to be replicated on a
second server, the replication server.

Central Instance

Receives client requests and forwards them
to the server processes accordingly.

Java Dispatcher

Java Server Processes Processes the requests and holds the session
data.

Dialog Instance

SDM

The Software Deployment Manager (SDM) is
a tool with which you can manage and deploy
software packages (Software Deployment
Archives and Software Component Archives)
that you receive from SAP to the Web AS
Java.

Java Dispatcher

Receives client requests and forwards them
to the server processes accordingly.
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Table 2-1
Architecture

Component

SAP architecture (continued)
Service

Functions

Java Server Processes Processes the requests and holds the session
data.
Central Services
Instance

Java Enqueue Service ■ Manages logical locks.
■

Ensures server synchronization.

Java Message Service ■ Acts as a central service for cluster
internal communication, such as event
notifications, broadcasts, exchange of
cache content, and so on.
■ Provides cluster state information to SAP
Web Dispatcher.
■ Keeps a list of application servers that can
be reached within the system.

SAP NetWeaver AS
Add-In

Enqueue Replication Java Enqueue
Instance
Replication Service

Enables the lock table to be replicated on a
second server, the replication server.

Central Instance
(ABAP and Java)

■

ABAP Dispatcher

Controls program that manages the
resources of R/3 applications.
■ Balances the assignments of the
transaction load to the work processes.
■ Manages buffer in main memory.
■

Connects to the presentation level.

■

Organizes the communication processes.

ABAP Work
processes

■

Acts as a service offered by a server and
requested by a client.
■ Manages the programs that handle
specific tasks.

Java Dispatcher

■

Receives client requests and accordingly
forwards them to the server for further
processing.

Java Server Processes ■ Handles the client-server processes and
maintains the session data.
SDM

■

Manages the software packages received
from SAP and deploys them on Web AS
Java.

Installing and configuring the SAP NetWeaver for high availability
About SAP NetWeaver

Table 2-1
Architecture

SAP architecture (continued)

Component

Service

Functions

Dialog Instance
(ABAP and Java)

ABAP Dispatcher

■

Controls the programs that manages the
resources of R/3 applications.
■ Balances assignment of the transaction
load to the work processes.
■ Manages buffer in main memory.
■

Connection with the presentation level.

■

Organizes the communication processes.

ABAP Work
processes

■

Acts as a service offered by a server and
requested by a client.
■ Acts as a special program in charge of
some specific tasks.

Java Dispatcher

Receives client requests and forwards them
to the server processes accordingly.

Java Server Processes Processes the requests and holds the session
data.
Central Services
Instance ABAP

Central Services
Instance Java

ABAP Enqueue
Service

■

Manages logical locks

■

Ensures server synchronization

ABAP Message
Service

■

Acts as a central service for cluster
internal communication, such as event
notifications, broadcasts, exchange of
cache content, and so on.
■ Provides cluster state information to SAP
Web Dispatcher
■ Keeps a list of application servers that can
be reached within the system.

Java Enqueue Service ■ Manages logical locks.
■

Ensures server synchronization.

Java Message Service ■ Acts as a central service for cluster
internal communication, such as event
notifications, broadcasts, exchange of
cache content, and so on.
■ Provides cluster state information to SAP
Web Dispatcher
■ Keeps a list of application servers that can
be reached within the system.
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Table 2-1
Architecture

SAP architecture (continued)

Component

Service

Functions

Enqueue Replication ABAP Enqueue
Instance ABAP
Replication Service

Enables the lock table to be replicated on a
second server, the replication server.

Enqueue Replication Java Enqueue
Instance Java
Replication Service

Enables the lock table to be replicated on a
second server, the replication server.

Single Point of Failures (SPOF)
In a distributed SAP environment, the following components are critical for
application availability. Hence, these components need to be protected.
■

Database Instance

■

Central Instance

■

Dialog Instance

■

Central Services Instance

■

SAP Central File System

Table 2-2 lists the possibilities to eliminate the single point of failures.
Table 2-2

Possibilities to secure the single point of failures

Single Point of Failure

Technical Possibilities to eliminate the SPOF

Central Database

Switch-over solutions

Central Services

Set up an Enqueue Replication Server controlled by
a switch-over solution

Central Instance/Dialog Instance

Switch-over solutions

SAP Central File System

Switch-over solutions

About SAPCPE
SAPCPE is a generic tool developed by SAP. The SAP startup framework launches
this tool before starting the actual instance.
SAPCPE is used in every high availability setup to automate the synchronization
of binaries and executables from a central location
(\\SAPGLOBALHOST\sapmnt\SYS\exe\run) to the instance specific local disks
(drive:\usr\sap\SID\InstName\exe). The SAPCPE tool requires the list of target
files to enable this synchronization.
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Uniquely identifying SAP server instances
You can virtualize an SAP instance using a cluster. Using shared disk and virtual
IP addresses, you can manage a large set of SAP instances in a single cluster. For
example, Dialog and Central instances can run on separate cluster nodes or can
run concurrently on a single node.
In cases such as multiple instances running concurrently on a single node, the
agent for SAP NetWeaver must be able to uniquely identify each SAP instance on
a single host system.
To uniquely identify each SAP instance, set the SAPSID and InstName attributes
such that the combined values of SAPSID and the last two characters of InstName
are unique for each SAP instance.
Differentiating SAP instances is important when the Agent for SAP NetWeaver
must kill the processes of a non-responsive or failed instance. In absence of unique
names for each server, the agent may kill processes for more than one SAP instance
during a clean operation.

Monitoring an SAP instance
The monitor function performs process level check to ensure the proper
functioning of an SAP instance.
The ProcMon attribute specifies the processes that must be running successfully
for a particular SAP instance type. The monitor function uses this list of processes
to scan the process table, and verify that the processes are running successfully.
Table 2-3 contains valid values for the ProcMon attribute.
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Table 2-3

Valid values for the ProcMon attribute

SAP usage type

SAP instance type

Value for ProcMon attribute

ABAP

■

CENTRAL

For CENTRAL:

■

DIALOG

■

■

ENQUEUE

■

ENQREP

Mandatory: disp+work.exe,
msg_server.exe
■ Optional: igswd.exe, icman.exe,
and gwrd.exe

Note: msg_server.exe is not
applicable for a Central instance,
if a Standalone Enqueue server
instance is configured.
For DIALOG:
■

Mandatory: disp+work.exe

■

Optional: igswd.exe, icman.exe
and gwrd.exe

For ENQUEUE:
■

msg_server.exe

■

enserver.exe

For ENQREP
■

Java

enrepserver.exe

■

CENTRAL

For CENTRAL:

■

DIALOG

■

Mandatory: jcontrol.exe

■

ENQUEUE

■

Optional: icman.exe

■

ENQREP

For DIALOG:
■

Mandatory: jcontrol.exe

■

Optional: icman.exe

For ENQUEUE:
Mandatory: disp+work.exe,
jcontrol.exe
■ Optional: igswd.exe, icman.exe
and gwrd.exe
■

For ENQREP
■

enrepserver.exe
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Table 2-3

Valid values for the ProcMon attribute (continued)

SAP usage type

SAP instance type

Value for ProcMon attribute

Add-In (ABAP + Java)

■

CENTRAL

For CENTRAL

■

DIALOG

■

■

AENQUEUE (ABAP)

■

JENQUEUE (Java)

■

AENQREP (REP)

Mandatory: disp+work.exe,
msg_server.exe, jcontrol.exe
■ Optional: igswd.exe, icman.exe
and gwrd.exe

■

JENQREP

DIALOG
Mandatory: disp+work.exe,
jcontrol.exe
■ Optional: igswd.exe, icman.exe
and gwrd.exe
■

For AENQUEUE (ABAP)
■

msg_server.exe

■

enserver.exe

For JENQUEUE (Java)
■

enrepserver.exe

For AENQREP (ABAP)
■

msg_server.exe

■

enserver.exe

For JENQREP (Java)
■

enrepserver.exe

The monitor function takes a snapshot of the running process table. The function
compares the processes that the ProcMon attribute specifies, to the set of running
SAP processes. If any process is missing, the function declares the SAP instance
as offline, and bypasses further monitor operations.

About installing SAP NetWeaver for high availability
You can install SAP NetWeaver in the following ways, in a VCS environment:
SAP instance on shared disk

SAP instance binaries are installed on shared disks.

SAP instance on local disk

SAP instance binaries are installed locally on each node.

When installing SAP NetWeaver, ensure that the login_name, group_name for
the sidadm and SAPServiceSID is the same on all the nodes.
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About configuring SAP NetWeaver for high availability
The guidelines for configuring SAP NetWeaver for high availability are as follows:
■

In a service group, keep the single point of failure as minimal as possible and
watch the application startup time.

■

Assign a virtual hostname to the component within the switchover envionment.
Since the physical hostname changes with the switchover, this is a must have
requirement.

■

Based on the expected failover time configure the reconnection parameters
for all software components and enable its automatic reconnection.

■

Configure sapcpe tool to load the executables from central file share to instance
specific directory.

Setting up SAP systems for clustering
This topic describes the procedure to install and configure SAP on a Windows
system, so that you can cluster the system in a Veritas Cluster Server (VCS)
environment.
Symantec recommends installing and clustering a database server for SAP to
minimize SAP system downtime. An SAP system downtime may happen due to
database unavailability.
In this installation, it is assumed that you are setting up the system on two or
more nodes, and clustering these nodes in a VCS environment.
Note: Symantec strongly recommends that a trained SAP consultant must be
involved in performing the installation procedure.

Setting up a pre-installed SAP R/3 system
If you have a previously installed SAP stem, the system can be of the following
types:
■

A domain administrator installed the system with a virtual hostname.

■

A domain administrator installed the system with a local hostname.

■

A local administrator installed the system with a virtual hostname.

■

A local administrator installed the system with a local hostname.
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For a domain administrator that has installed the SAP system using a virtual
hostname.
See “Clustering an SAP instance” on page 62.
For all other types, perform the following procedures as applicable:
■

Converting a local installation into a domain installation

■

Converting the local environment into a virtual environment

Converting a local installation into a domain installation
If a local administrator has installed the SAP system, convert the installation into
a domain installation.
To convert a local installation into a domain installation

1

Ensure that the necessary user accounts and user groups such as sapsidadm,
SAPserviceSAPSID, and so on, exist in the domain controller.
For details about creating user accounts and user groups in the domain
controller:
See “Creating and adding domain groups and users” on page 69.

2

Add these domain user accounts to the SAP server, and assign these accounts
to the group of local administrators for the SAP server.
For details about adding local groups and users:
See “Creating and adding local groups and users” on page 72.

3

The SAP services, such as SAP<SAPSID>_<xx> and SAPOSCol, use a user to
begin execution.
Change the user of these services as follows:

4

■

Stop the SAP system and its services.

■

For each service, right-click the service, and select Properties.

■

In the Service Properties dialog box, click the Logon tab.

■

Change the user of the service to the domain user that you created in step
1.

Ensure that the sapmnt and saploc directories are shared, and are accessible
by the domain user.
Perform the following steps in the order presented:
■

Right-click the <drive>:\usr\sap directory, and select Properties.

■

In the Properties dialog box, click the Sharing tab.
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5

■

Click Share this folder.

■

Enter sapmnt in the Share name field.

■

Click Permissions.

■

In the Permissions for sapmnt dialog box, ensure that the Administrators
and SAP_LocalAdmin user groups have full control for the sapmnt
directory.

■

Click OK in the Permissions for sapmnt dialog box.

■

In the Properties dialog box, click New Share.

■

In the New Share dialog box, enter saploc in the Share name field.

■

Click OK in the New Share dialog box.

■

Click Permissions.

■

In the Permissions for saploc dialog box, ensure that the Administrators
and SAP_LocalAdmin user groups have full control for the saploc directory.

■

Click OK in the Permissions for saploc dialog box.

■

Click OK in the Properties dialog box.

Restart the SAP system and its services.

Converting the local environment into a virtual environment
If the SAP system uses a local hostname, you must convert the local environment
of the system into a virtual environment.
Note: Ensure that a domain administrator has installed the SAP installation. If
the installation is local, convert the installation into a domain installation.
See “Converting a local installation into a domain installation” on page 31.
To convert the local environment into a virtual environment

1

On all the nodes in the cluster, set the sapsidadm user environment variables.
Do the following tasks, in the order presented:
■

Open a command prompt window.

■

At the command prompt, type runas /profile
/user:<domain>\<sapsid>adm regedit.

■

In the Registry Editor dialog box, click HKEY_CURRENT_USER >
Environment.
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■

2

Set the environment variables.
See “Setting the environment variables” on page 36.

On the drive where SAP is installed, access the DEFAULT.PFL file in the
<drive>:\usr\sap\SAPSID\SYS\profile directory.
Do the following tasks, in the order presented:

3

■

Set the SAPDBHOST parameter as equal to the virtual hostname of the
database server.

■

Set any references of the database server as equal to the virtual hostname
of the database server.

■

Set all other references of the local hostname as equal to the virtual
hostname of the SAP instance.

On the drive where SAP is installed, access the START profile in the
<drive>:\usr\sap\SAPSID\SYS\profile directory.
Do the following tasks, in the order presented:

4

■

Rename the START_InstName_RealHostname file to reflect the virtual
hostname of the SAP instance.
The filename becomes START_InstName_VirtualHostname.

■

Set the SAPGLOBALHOST parameter as equal to the virtual hostname of
the Central instance.

■

Set the SAPLOCALHOST and SAPLOCALHOSTFULL parameters as equal
to the virtual hostname of the instance.

■

Comment out the SAP commands that initiate the database. The
appropriate database agent must initiate the database.

■

Change all other references of the local hostname as equal to the virtual
hostname of the instance.

On the drive where SAP is installed, access the instance profile in the
<drive>:\usr\sap\SAPSID\SYS\profile directory.
Do the following tasks, in the order presented:
■

Rename the SAPSID_InstName_RealHostname file to reflect the virtual
hostname of the SAP instance.
The filename becomes SAPSID_InstName_VirtualHostname.

■

Set the SAPGLOBALHOST parameter as equal to the virtual hostname of
the Central instance.

■

Set the SAPLOCALHOST and SAPLOCALHOSTFULL parameters as equal
to the virtual hostname of the instance.
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■

5

Change all other references of the local hostname as equal to the virtual
hostname of the instance.

On the drive where SAP is installed, access the igs.xml file in the
<drive>:\usr\sap\SAPSID\InstName\igs\conf directory.
Do the following tasks, in the order presented:
■

Set the ip parameter in MUX as equal to the virtual hostname of the
instance.

■

Set the gwhost parameter as equal to the virtual hostname of the instance.

■

Change all other references to the local hostname as equal to the virtual
hostname of the instance.

6

On the drive in which SAP is installed, access the
<drive>:\usr\sap\SAPSID\SYS\exe\run directory or
<drive>:\usr\sap\SAPSID\InstName\exe directory.

7

Use the sapstartsrv.exe command to recreate the Windows service entry.

8

Perform either of these steps to recreate the service entry as follows:
■

At the command prompt run the sapstartsrv.exe command.

■

In the SAP Service Install/Uninstall dialog box, enter the following values:
SID

SAPSID

NR

InstID

Startprofile

■

User

<SAPAdminDomain>\SAPService<SAPSID>

Password

<SAPService<SAPSID> password>

Startup Type

Manual

Use Environment of user

<SAPAdminDomain>\<sapsid>adm

For a global host:
<drive>:\usr\sap\SAPSID\SYS\profile\START_
InstName_Virtual_HostName
■ For other hosts:
\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\
SYS\profile\START_<InstName>_<Virtual_
HostName>

■

Click OK.

■

Create the Windows service entry using the following command:
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sapstartsrv.exe -r -q -s <SAPSID> -n <InstID> -U\
<SAPAdminDomain>\SAPService<SAPSID> -P\ <SAPService<SAPSID>
password> -p
■

For a global host, add the following lines:
<drive>:\usr\sap\<SAPSID>\SYS\profile\START_<InstName>_<V.Ho
stName> -e <SAPAdminDomain>\<sapsid>adm

■

For other hosts, add the following lines:
\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile\START_<InstNam
e>_<Virtual_HostName> -e <SAPAdminDomain>\<sapsid>adm

9

As and where applicable, backup the following directories by renaming the
directories:
<drive>:\usr\sap\<SAPSID>\SYS
<drive>:\usr\sap\<SAPSID>\SYS\profile
<drive>:\usr\sap\<SAPSID>\SYS\global
<drive>:\usr\sap\<SAPSID>\<InstName>

10 As and where applicable, create and mount a new shared volume for the
following mount points:
<drive>:\usr\sap\<SAPSID>\SYS
<drive>:\usr\sap\<SAPSID>\SYS\profile
<drive>:\usr\sap\<SAPSID>\SYS\global
<drive>:\usr\sap\<SAPSID>\<InstName>

11 Copy the file referenced in step 9 into the new volumes, as and where
applicable.

12 On the nodes in the cluster where the files referenced in step 9, were not
modified, recreate these directories:
<drive>:\usr\sap\<SAPSID>\SYS
<drive>:\usr\sap\<SAPSID>\SYS\profile
<drive>:\usr\sap\<SAPSID>\SYS\global
<drive>:\usr\sap\<SAPSID>\<InstName>

The SAP system is now ready for clustering. For details about clustering:
See “Clustering an SAP instance” on page 62.
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Setting the environment variables
Table 2-4 lists the environment variables that you need to convert the local
environment into a virtual environment.
The database server is a Microsoft SQL database server.
Table 2-4

Environment variables

Parameter name

Parameter type

Data

DBMS_TYPE

REG_SZ

MSS

MSSQL_DBNAME

REG_SZ

<SAPSID>

MSSQL_SCHEMA

REG_SZ

<sapsid>

MSSQL_SERVER

REG_SZ

<DBHost>\<DBInstance>

PATH

REG_EXPAND_SZ

<Path to all SAP instances’
binaries in the SAP system>
Separate each instance path
with ;.

SAPGLOBALHOST

REG_SZ

<SAPGLOBALHOST>

SAPLOCALHOST

REG_SZ

<SAPLOCALHOST>

TEMP

REG_EXPAND_SZ

C:\WINDOWS\TEMP

TMP

REG_EXPAND_SZ

C:\WINDOWS\TEMP

Note: For Oracle database, configure the the environment variables accordingly.

Fresh SAP installation: Installing an SAP ABAP system
This section describes the procedure to install an SAP system with ABAP
architecture in a highly available environment. The procedure assumes that VCS
is installed on the system.

Installing an SAP ABAP ASCS instance
This section is applicable for SAP NetWeaver 04s only. Follow these steps to install
an SAP ABAP ASCS instance.
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To install an SAP ABAP ASCS instance

1

Log in as a user that has domain administrator rights.

2

Create a VCS Service Group with IP and Lanman resources.
For details about creating VCS Service Groups, refer to the VCS user
documentation.

3

Before beginning to install the SAP ABAP ASCS instance, bring the Service
Group online.

4

On the node that has the Service Group online, start the SAP installation.
Do not double-click the sapinst.exe file to launch the SAP installation GUI.
Use the SAPINST_USE_HOSTNAME parameter to launch the SAP installation
GUI in a virtual environment. At the command prompt, run this command:
<path>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

where:
<Virtual Host Name> is the virtual lanman name that you created in step 2.

5

From the installation GUI, select High-Availability System > Based on AS
ABAP > Central Services Instance for ABAP (ASCS) and follow the
instructions to complete the installation.

Installing an SAP ABAP Central instance
Follow these steps to install an SAP ABAP Central instance.
To install an SAP ABAP Central instance

1

Log in as a user that has domain administrator rights.

2

Create a VCS Service Group with IP and Lanman resources.
For details about creating VCS Service Groups, refer to the VCS user
documentation.
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3

Before beginning to install the Central instance, bring the Service Group
online.

4

On the node that has the Service Group online, start the SAP installation.
Do not double-click the sapinst.exe file to launch the SAP installation GUI.
Use the SAPINST_USE_HOSTNAME parameter to launch the SAP installation
GUI in a virtual environment. At the command prompt, run this command:
<path>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

where:
<Virtual Host Name> is the virtual lanman name that you created in step 2.
Follow the instructions in the SAP installation GUI, and complete the SAP
Central instance installation.
Installing the SAP Central instance populates the SAPGLOBALHOST
parameter. This step is not applicable for SAP NetWeaver 04s.
To install an SAP ABAP Central instance for SAP NetWeaver 04s

1

Select High-Availability System > Based on AS ABAP > Central Instance
from the SAP installation GUI and follow the instructions to complete the
installation.

2

Under SAP System Parameters, specify the virtual SCS host name in the
Profile Directory field. For example:
\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile

Installing an SAP ABAP Database instance
On the node where the database is up and running, begin the SAP database instance
installation.
Do not double-click the sapinst.exe file to launch the SAP installation GUI. Use
the SAPINST_USE_HOSTNAME parameter to launch the SAP installation GUI in
a virtual environment. At the command prompt, run the following command:
<path>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

where:
<Virtual Host Name> is the virtual hostname of the system on which the database
is running.
Follow the instructions in the SAP installation GUI, and complete the SAP Database
instance installation.
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Installing an SAP ABAP Dialog instance
Follow these steps to install an SAP ABAP Dialog instance.
To install SAP ABAP Dialog instance

1

Log in as a user that has domain administrator rights.

2

Create a VCS Service Group with IP and Lanman resources.
For details about creating VCS Service Groups, refer to the VCS user
documentation.

3

Before beginning to install the Dialog instance, bring the Service Group online.

4

On the node that has the Service Group online, start the SAP installation.
Do not double-click the sapinst.exe file to launch the SAP installation GUI.
Use the SAPINST_USE_HOSTNAME parameter to launch the SAP installation
GUI in a virtual environment. At the command prompt, run this command:
<path>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

where:
<Virtual Host Name> is the virtual lanman name that you created in step 2.
Follow the instructions in the SAP installation GUI, and complete the SAP
Dialog instance installation.
To install an SAP ABAP Dialog instance for SAP NetWeaver 04s

1

Select High-Availability System > Based on AS ABAP > Dialog Instance
from the SAP installation GUI and follow the instructions to complete the
installation.

2

Under SAP System Parameters, specify the virtual SCS host name in the
Profile Directory field. For example:
\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile

For details about clustering:
See “Clustering an SAP instance” on page 62.

Installing an SAP ABAP Standalone Enqueue server
The Standalone Enqueue server is shipped along with the standard SAP
installation, but the sapinst.exe file does not install and configure the Enqueue
server. You must configure the server separately, after installing the SAP Central
instance.
This section is applicable for the versions lesser than SAP NetWeaver 04s.
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Assume the following:
■

Central instance is DVEBMGS<xx>.

■

SAP system name is EC4.

■

Virtual hostnames of the Standalone Enqueue server and application server
instances are SAPEC4ASCS and SAPEC4CI respectively.

■

Instance numbers for the Standalone Enqueue server and application server
instances are 10 and 12 respectively.

You must first split the Central instance into two instances. For example, split
DVEBMGS<xx> into two instances, ASCS<xx> and DVBGS<yy>. The ASCS<xx> instance
includes all the centralized components.
The ASCS<xx> instance is an Enqueue server instance, and the DVBGS<yy> instance
is an application server instance.
To install and configure a SAP ABAP Standalone Enqueue server

1

Make two copies of the start and instance profiles of the Central instance.

2

Name the start profiles as follows:
■

START_DVBGS12_SAPEC4CI

start profile for an application server instance
■

START_ASCS10_SAPEC4ASCS

start profile for a Standalone Enqueue server instance

3

In the START_DVBGS12_SAPEC4CI profile, do the following:
■

Change the values of the following parameters:
INSTANCE_NAME

DVBGS12

SAPGLOBALHOST

SAPEC4ASCS

SAPLOCALHOST

SAPEC4CI

SAPSYSTEM

12

DIR_INSTANCE

c:\usr\sap\EC4\DVBGS12

DIR_EXECUTABLE

$(DIR_INSTANCE)\exe

DIR_LIBRARY

$(DIR_INSTANCE)\exe

DIR_PROFILE

\\SAPEC4ASCS\sapmnt\EC4\SYS\profile

DIR_GLOBAL

\\SAPEC4ASCS\sapmnt\EC4\SYS\global
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DIR_CT_RUN

■
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\\SAPEC4ASCS\sapmnt\EC4\SYS\exe\run

Remove the following lines:
_DB=strdbs.cmd
Start_Program_02=immediate $(DIR_EXECUTABLE)\$(_DB) EC4
_MS=msg_server.exe
Start_Program_03=local $(DIR_EXECUTABLE)\$(_MS) pf=$(DIR_PROFILE)\
EC4_DVEBMGS10_SAPEC4ASCS
_DW=disp+work.exe
Start_Program_04=local $(DIR_EXECUTABLE)\$(_DW) pf=$(DIR_PROFILE)\
EC4_DVEBMGS10_SAPEC4ASCS
_IGS=igswd.exe
Start_Program_06=local $(DIR_INSTANCE)\igs\bin\$(_IGS)
-dir=$(DIR_INSTANCE)\igs -mode=all -sysname=EC4 -sysno=10

■

Add the following lines:
_CP=sapcpe.exe
Start_Program_01=immediate $(DIR_EXECUTABLE)\$(_CP)
pf=$(DIR_PROFILE)\EC4_DVBGS12_SAPEC4CI
_DW=disp+work.exe
Start_Program_04=local $(DIR_EXECUTABLE)\$(_DW)
pf=$(DIR_PROFILE)\EC4_DVBGS12_SAPEC4CI
_IGS=igswd.exe
Start_Program_06=local $(DIR_INSTANCE)\igs\bin\$(_IGS)
-dir=$(DIR_INSTANCE)\igs -mode=all -sysname=EC4 -sysno=12

4

In the START_ASCS10_SAPEC4ASCS profile, do the following:
■

Change the values of the following parameters:
SAPGLOBALHOST

SAPEC4ASCS

SAPLOCALHOST

SAPEC4ASCS

INSTANCE_NAME

ASCS10

SAPSYSTEM

10

DIR_EXECUTABLE

c:\usr\sap\EC4\ASCS10\exe

DIR_LIBRARY

c:\usr\sap\EC4\ASCS10\exe

DIR_PROFILE

c:\usr\sap\EC4\SYS\profile
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■

DIR_GLOBAL

c:\usr\sap\EC4\SYS\global

DIR_CT_RUN

C:\usr\sap\EC4\SYS\exe\run

Remove the following lines:
_DB=strdbs.cmd
Start_Program_02=immediate $(DIR_EXECUTABLE)\$(_DB) EC4
_MS=msg_server.exe
Start_Program_03=local $(DIR_EXECUTABLE)\$(_MS)
pf=$(DIR_PROFILE)\EC4_DVEBMGS10_SAPEC4ASCS
_DW=disp+work.exe
Start_Program_04=local $(DIR_EXECUTABLE)\$(_DW)
pf=$(DIR_PROFILE)\EC4_DVEBMGS10_SAPEC4ASCS
_IGS=igswd.exe
Start_Program_06=local $(DIR_INSTANCE)\igs\bin\$(_IGS)
-dir=$(DIR_INSTANCE)\igs -mode=all -sysname=EC4 -sysno=10

■

Add the following lines:
_CP = sapcpe.exe
Start_Program_00 = immediate $(DIR_EXECUTABLE)\$(_CP)
pf=$(DIR_PROFILE)\EC4_ASCS10_SAPEC4ASCS
_MS=msg_server.exe
Start_Program_01=local $(DIR_EXECUTABLE)\$(_MS)
pf=$(DIR_PROFILE)\EC4_ASCS10_SAPEC4ASCS
_EN = enserver.exe
Start_Program_02 = local $(DIR_EXECUTABLE)\$(_EN)
pf=$(DIR_PROFILE)\EC4_ASCS10_SAPEC4ASCS

5

Name the instance profiles as follows:
■

EC4_DVBGS12_SAPEC4CI

instance profile of the application server instance
■

EC4_ASCS10_SAPEC4ASCS

instance profile of the Standalone Enqueue server instance

6

In the EC4_DVBGS12_SAPEC4CI profile, do the following:
■

Change the values of the following parameters:
INSTANCE_NAME

DVBGS12

SAPSYSTEM

12
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■

SAPGLOBALHOST

SAPEC4ASCS

SAPLOCALHOST

SAPEC4CI

DIR_GLOBAL

\\SAPEC4ASCS\sapmnt\EC4\SYS\global

DIR_PROFILE

\\SAPEC4ASCS\sapmnt\EC4\SYS\profile

DIR_INSTANCE

C:\usr\sap\EC4\DVBGS12

DIR_EXECUTABLE

$(DIR_INSTANCE)\exe

DIR_CT_RUN

\\SAPEC4ASCS\sapmnt\EC4\SYS\exe\run

DIR_TRANS

\\SAPEC4ASCS\sapmnt\trans

Remove the following line.
rdisp/wp_no_enq=1

■

Change the value of PORT in the following line.
icm/server_port_0=PROT=HTTP,PORT=8012

7

In the EC4_ASCS10_SAPEC4ASCS profile, do the following:
■

■

Change the values of the following parameters:
INSTANCE_NAME

ASCS10

SAPGLOBALHOST

SAPEC4ASCS

SAPLOCALHOST

SAPEC4ASCS

SAPSYSTEM

10

Remove the following lines:
rdisp/wp_no_dia=2
rdisp/wp_no_btc=2
rdisp/wp_no_vb=1
rdisp/wp_no_vb2=1
rdisp/wp_no_enq=1
rdisp/wp_no_spo=1
PHYS_MEMSIZE=512
DIR_TRANS=C:\usr\sap\trans
icm/server_port_0=PROT=HTTP,PORT=8010
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■

Add the following lines:
rdisp/myname = SAPEC4ASCS_EC4_10
enque/server/threadcount = 1
ipc/shm_psize_34 = 0
enque/table_size = 4096
enque/deque_wait_answer = FALSE
enque/process_location = LOCAL
enque/encni/port = 3210
rdisp/enqname = $(rdisp/myname)
enque/snapshot_pck_ids = 100
rdisp/mshost=SAPEC4ASCS
rdisp/msserv = 3610
ms/server_port_0=PROT=HTTP, PORT=8110

8

In the DEFAULT.PFL file, do the following:
■

Remove the following lines:
SAPDBHOST=SAPEC4ASCS
rdisp/accept_remote_trace_level=0
rdisp/sna_gateway=SAPEC4ASCS
rdisp/sna_gw_service=sapgw10
rslg/collect_daemon/listen_port=37
rslg/collect_daemon/talk_port=13
rdisp/bufrefmode=sendoff,exeauto
dbms/type=mss
dbs/mss/server=SAPNWDB\SQLINST01
dbs/mss/schema=ec4
dbs/mss/dbname=EC4

■

Add these lines:
SAPDBHOST=SAPNWDB #virtual hostname of the database server
rdisp/accept_remote_trace_level=0
rdisp/sna_gateway=SAPEC4CI
rdisp/sna_gw_service=sapgw12
rslg/collect_daemon/listen_port=37
rslg/collect_daemon/talk_port=13
rdisp/bufrefmode=sendon,exeauto
dbms/type=mss
dbs/mss/server=SAPNWDB\SQLINST01
dbs/mss/schema=ec4
dbs/mss/dbname=EC4
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enque/process_location = REMOTESA
enque/serverhost = SAPEC4ASCS
enque/serverinst = 10
enque/encni/port = 3210

The Standalone Enqueue server is now configured and is ready for clustering.
For details about clustering:
See “Clustering an SAP instance” on page 62.

Installing an SAP ABAP Enqueue Replication server
Follow the instructions here to install and configure an SAP ABAP Enqueue
Replication server.
See “Installing an SAP Enqueue Replication server” on page 58.

Fresh SAP installation: Installing an SAP Java system
This section describes the procedure to install an SAP system with Java
architecture in a highly available environment. The procedure assumes that VCS
is installed on the system.
Perform the instance installation in the order presented as follows.

Installing an SAP Java Central Services instance
This section explains the steps to install an SAP Java Central Services instance.
To install an SAP Java Central Services instance

1

Log in as a user that has domain administrator rights.

2

Create a VCS Service Group with IP and Lanman resources.
For details about creating VCS Service Groups, refer to the VCS user
documentation.

3

Before beginning to install the SAP Java Central Services instance, bring the
Service Group online.
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4

On the node that has the Service Group online, start the SAP installation.
Do not double-click the sapinst.exe file to launch the SAP installation GUI.
Use the SAPINST_USE_HOSTNAME parameter to launch the SAP installation
GUI in a virtual environment. At the command prompt, run the following
command:
SAP NetWeaver 04s

<path>\sapinst.exe
SAPINST_USE_HOSTNAME=<Virtual Host Name>

Other SAP versions

<path>\sapinst.exe
SAPINST_USE_HOSTNAME=<Virtual Host Name>
product_ha.catalog

where:
<Virtual Host Name> is the virtual lanman name that you created in step 2.

5

From the installation GUI, select one of the following options and follow the
instructions to complete the installation.
SAP NetWeaver 04s

High-Availability System > Based on AS Java > Central
Services Instance (SCS)

Other SAP versions

SAP Java Central Services Instance

Installing an SAP Java Database instance
This section is applicable for SAP NetWeaver 04s only. Follow these steps to install
an SAP Java Database instance.
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To install an SAP Java Database instance

1

On the node where the database is up and running, begin the SAP database
instance installation.
Do not double-click the sapinst.exe file to launch the SAP installation GUI.
Use the SAPINST_USE_HOSTNAME parameter to launch the SAP installation
GUI in a virtual environment. At the command prompt, run the following
command:
<path>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

where:
<Virtual Host Name> is the virtual hostname of the system on which the
database is running.

2

From the installation GUI, select High-Availability System > Based on AS
Java > Database Instance and follow the instructions to complete the
installation.

Installing an SAP Java Central instance
Ensure that you install an SAP Java Central Services instance before installing a
Central instance.
See “Installing an SAP Java Central Services instance” on page 45.
For SAP NetWeaver 04s, use the following command:
<path>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

For other versions, use the following command:
<path>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>
product_ha.catalog

Select the option for SAP Java Central instance from the installation GUI, and
follow the instructions to complete the installation.
When prompted for the SCS instance host name, enter the virtual host name of
the SAP Java Central Services instance.
For SAP NetWeaver 04s, do the following:
■

Select High-Availability System > Based on AS Java > Central Instance from
the SAP installation GUI and follow the instructions to complete the
installation.

■

Under SAP System Parameters, specify the virtual SCS host name in the Profile
Directory field. For example:
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\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile

Installing an SAP Java Dialog instance
This section explains the steps to install an SAP Java Dialog instance.
To install an SAP Java Dialog instance
Install the Java Dialog instance.
See “Installing an SAP ABAP Dialog instance” on page 39.
For SAP NetWeaver 04s, use the following command:
<Path_to_SAPInst>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

For other SAP versions, use the following command:
<Path_to_SAPInst>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>
product_ha.catalog

Select the option for SAP Java Dialog instance from the installation GUI, and
follow the instructions to complete the installation.
When prompted for the Central instance host name, enter the virtual host name
of the SAP Java Central Services instance.
For SAP NetWeaver 04s, do the following:
■

Select High-Availability System > Based on AS Java > Dialog Instance from
the SAP installation GUI and follow the instructions to complete the
installation.

■

Under SAP System Parameters, specify the virtual SCS host name in the Profile
Directory field. For example:
\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile

For details about clustering:
See “Clustering an SAP instance” on page 62.

Installing an SAP Java Enqueue Replication server
Follow the instructions to install and configure an SAP Java Enqueue Replication
server.
See “Installing an SAP Enqueue Replication server” on page 58.
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Fresh SAP installation: Installing a Java Add-In system
(ABAP + Java)
This section describes the procedure to install an SAP system in which a Java
Add-In is added to the ABAP architecture in a highly available environment. The
procedure assumes that VCS is installed on the system.
Perform the instance installation in the order presented as follows.

Installing an SAP Add-In ASCS instance
This section is applicable for SAP NetWeaver 04s only. Follow the instructions to
install an SAP Add-In ASCS instance.
See “Installing an SAP ABAP ASCS instance” on page 36.
From the installation GUI, select High-Availability System > Based on AS ABAP
and AS Java > Central Services Instance for ABAP (ASCS) and follow the
instructions to complete the installation.

Installing an SAP Add-In SCS instance
This section is applicable for SAP NetWeaver 04s only. Follow the instructions to
install an SAP Add-In SCS instance. Use the IP and Lanman resources that you
created for the SAP Add-In ASCS instance.
See “Installing an SAP Add-In ASCS instance” on page 49.
To install an SAP Add-In SCS instance

1

Log in as a user that has domain administrator rights.

2

Before beginning to install the SAP Add-In SCS instance, bring the Service
Group in which the SAP Add-In ABAP instance is installed, online.

3

On the node that has the Service Group online, start the SAP installation. Do
not double-click the sapinst.exe file to launch the SAP installation GUI. Use
the SAPINST_USE_HOSTNAME parameter to launch the SAP installation
GUI in a virtual environment. At the command prompt, run this command:
<path>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

where:<Virtual Host Name> is the virtual lanman name.

4

From the installation GUI, select High-Availability System > Based on AS
ABAP > Central Services Instance (SCS) and follow the instructions to
complete the installation.
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Installing an SAP ABAP Central instance for an Add-In system
Follow the instructions to install an SAP ABAP Central instance.
See “Installing an SAP ABAP Central instance” on page 37.
For SAP NetWeaver 04s, do the following:
■

Select High-Availability System > Based on AS ABAP and AS Java > Central
Instance from the installation GUI, to install an SAP Add-In Central instance.

■

Under SAP System Parameters, specify the virtual SCS host name in the Profile
Directory field. For example:
\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile

Installing an SAP ABAP Database instance for an Add-In system
Install an SAP ABAP Database instance.
See “Installing an SAP ABAP Database instance” on page 38.
For SAP NetWeaver 04s, do the following:
■

Select High-Availability System > Based on AS ABAP and AS Java > Database
Instance from the installation GUI, to install an SAP Add-In Database instance.

■

Under SAP System Parameters, specify the virtual SCS host name in the Profile
Directory field. For example:
\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile

Installing a Java Add-In for a Central instance
For SAP NetWeaver 04s, this section is not applicable if you select the
High-Availability option while installing the SAP ABAP Central instance for an
Add-In system.
After installing the SAP ABAP Central and Database instance, follow these steps
to install a Java Add-In for the Central instance.
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To install a Java Add-In for a Central instance

1

Log in as a user that has domain administrator rights.

2

Bring the service group, which you created in the SAP ABAP Central instance
for an Add-In system, online.
See “Installing an SAP ABAP Central instance for an Add-In system”
on page 50.

3

On the node that has the Service Group online, start the Java Add-In system
installation.
Do not double-click the sapinst.exe file to launch the SAP installation GUI.
Use the SAPINST_USE_HOSTNAME parameter to launch the SAP installation
GUI in a virtual environment. At the command prompt, run this command:
<path>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

where:
<Virtual Host Name> is the virtual lanman name of the SAP Add-In Central
instance.
Select Java Add-In for ABAP > Java System Finalization from the installation
GUI, and follow the instructions to complete the installation.

Installing an SAP ABAP Dialog instance for an Add-In system
Install an SAP ABAP dialog instance.
See “Installing an SAP ABAP Dialog instance” on page 39.
For SAP NetWeaver 04s, do the following:
■

Select High-Availability System > Based on AS ABAP and AS Java > Dialog
Instance from the installation GUI, to install an SAP Add-In Dialog instance.

■

Under SAP System Parameters, specify the virtual SCS host name in the Profile
Directory field. For example:
\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile

Installing a Java Add-In for a Dialog instance
For SAP NetWeaver 04s, this section is not applicable if you select the
High-Availability option while installing the SAP ABAP Dialog instance for an
Add-In system.
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After installing an SAP ABAP Dialog instance, follow these steps to install a Java
Add-In for the Dialog instance.
To install a Java Add-In for a Dialog instance

1

Bring the dialog instance that you installed in the Java Add-In for a Dialog
instance, online.
See “Installing a Java Add-In for a Dialog instance” on page 51.

2

Begin the installation. Do not double-click the sapinst.exe file to launch the
SAP installation GUI. Use the SAPINST_USE_HOSTNAME parameter to
launch the SAP installation GUI in a virtual environment. At the command
prompt, run this command:
<path>\sapinst.exe SAPINST_USE_HOSTNAME=<Virtual Host Name>

where:
<Virtual Host Name> is the virtual lanman name of the SAP Add-In Central
instance.
Select Java Add-In for ABAP > Dialog Instance Finalization from the
installation GUI, and follow the instructions to complete the installation.
For details about clustering:
See “Clustering an SAP instance” on page 62.

Installing an SAP Add-In Standalone Enqueue server
For SAP NetWeaver 04s, this section is not applicable if you select the
High-Availability option in the SAP installation GUI. For SAP NetWeaver 04s, the
procedure to install an SAP Add-In Standalone Enqueue server is integrated with
the SAPInst tool.
For other SAP versions, in an SAP Add-In system, you require the following:
■

A Standalone Enqueue server and a message server with ABAP architecture.

■

A Standalone Enqueue server and a message server with Java architecture.
This Enqueue server is shipped as part of the SAP installation.

For high availability, you must isolate the ASCS instance. To isolate the ASCS
instance, you must split the Central instance into two instances. One instance
includes the dialog, update, background, and spool work processes, while the other
instance becomes a disconnected ASCS instance, containing the message and the
Enqueue servers.
If you restart this disconnected ASCS instance on the Central Services instance
host, the instance is relocated on the Central Services instance host.
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The remaining instance on the Central instance host must not be renamed as
DVBGS<xx>. Renaming this instance may lead to problems with an existing J2EE
Add-In system, or with an awaiting J2EE installation. In addition, the path names
are firmly connected to various points in the J2EE engine. Therefore, this instance
name must not be changed. For more information, refer to SAP note 821904.
Before you install an SAP Add-In Standalone Enqueue server, assume the following:
■

The original Central instance is DVEBMGS<xx>, and the instance is split into
the following instances:
ASCS<yy>

SAP Add-In Standalone Enqueue server instance

DVEBMGS<xx>

Application server instance

■

The value of SAPSID is XI1.

■

The virtual host name of the Central and Standalone Enqueue server is
SAPXI1ASCS.

■

The instance numbers of the Central and Standalone Enqueue server instances
are 41 and 42 respectively.

To install and configure an SAP Add-In Standalone Enqueue server

1

Make a copy of the start profile of the Central instance.
Name the start profiles as follows:

2

■

START_DVEBMGS41_SAPXI1ASCS
The start profile for the application server instance

■

START_ASCS42_SAPXI1ASCS
The start profile for the Standalone Enqueue server

In the START_DVEBMGS41_SAPXI1ASCS profile, do the following:
■

Change the values of the following parameters:
DIR_EXECUTABLE

C:\usr\sap\XI1\SYS\exe\run

DIR_LIBRARY

C:\usr\sap\XI1\SYS\exe\run

DIR_INSTANCE

C:\usr\sap\XI1\DVEBMGS41

DIR_GLOBAL

C:\usr\sap\XI1\SYS\global

DIR_PROFILE

C:\usr\sap\XI1\SYS\profile

DIR_CT_RUN

C:\usr\sap\XI1\SYS\exe\runU
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■

Remove the following lines:
_DB=strdbs.cmd
Start_Program_02=immediate $(DIR_EXECUTABLE)\$(_DB) XI1
_MS=msg_server.exe
Start_Program_03=local $(DIR_EXECUTABLE)\$(_MS)
pf=$(DIR_PROFILE)\XI1_DVEBMGS41_SAPXI1ASCS

3

In the START_ASCS42_SAPXI1ASCS profile, do the following:
■

■

Change the values of the following parameters:
SAPGLOBALHOST

SAPXI1ASCS

SAPLOCALHOST

SAPXI1ASCS

INSTANCE_NAME

ASCS42

SAPSYSTEM

42

DIR_EXECUTABLE

C:\usr\sap\XI1\ASCS42\exe

DIR_LIBRARY

C:\usr\sap\XI1\ASCS42\exe

DIR_INSTANCE

C:\usr\sap\XI1\ASCS42

DIR_GLOBAL

C:\usr\sap\XI1\SYS\global

DIR_PROFILE

C:\usr\sap\XI1\SYS\profile

DIR_CT_RUN

C:\usr\sap\XI1\SYS\exe\runU

Remove the following lines:
_DB=strdbs.cmd
Start_Program_02=immediate $(DIR_EXECUTABLE)\$(_DB) XI1
_MS=msg_server.exe
Start_Program_03=local $(DIR_EXECUTABLE)\$(_MS)
pf=$(DIR_PROFILE)\XI1_DVEBMGS41_SAPXI1ASCS
_DW=disp+work.exe
Start_Program_04=local $(DIR_EXECUTABLE)\$(_DW)
pf=$(DIR_PROFILE)\XI1_DVEBMGS41_SAPXI1ASCS
_IGS=igswd.exe
Start_Program_06=local $(DIR_INSTANCE)\igs\bin\$(_IGS)
-dir=$(DIR_INSTANCE)\igs -mode=all -sysname=XI1 -sysno=41

■

Add the following lines:
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_CP = sapcpe.exe
Start_Program_00 = immediate $(DIR_EXECUTABLE)\$(_CP)
list:$(DIR_CT_RUN)\instance.lst pf=$(DIR_PROFILE)\
XI1_ASCS42_SAPXI1ASCS
_MS=msg_server.exe
Start_Program_01=local $(DIR_EXECUTABLE)\$(_MS)
pf=$(DIR_PROFILE)\XI1_ASCS42_SAPXI1ASCS
_EN = enserver.exe
Start_Program_02 = local $(DIR_EXECUTABLE)\$(_EN)
pf=$(DIR_PROFILE)\XI1_ASCS42_SAPXI1ASCS

4

Make a copy of the instance profile of the Central instance.
Name the profiles as follows:
■

XI1_DVEBMGS41_SAPXI1ASCS

The instance profile for the Standalone Enqueue server instance
■

XI1_ASCS42_SAPXI1ASCS

The instance profile for the application server instance

5

In the XI1_DVEBMGS41_SAPXI1ASCS profile, do the following:
■

■

Change the values of the following parameters:
SAPGLOBALHOST

SAPXI1ASCS

SAPLOCALHOST

SAPXI1ASCS

INSTANCE_NAME

DVEBMGS41

SAPSYSTEM

41

DIR_EXECUTABLE

C:\usr\sap\XI1\SYS\exe\run

DIR_LIBRARY

C:\usr\sap\XI1\SYS\exe\run

DIR_INSTANCE

C:\usr\sap\XI1\DVEBMGS41

DIR_GLOBAL

C:\usr\sap\XI1\SYS\global

DIR_PROFILE

C:\usr\sap\XI1\SYS\profile

DIR_CT_RUN

C:\usr\sap\XI1\SYS\exe\runU

Remove the following line:
rdisp/wp_no_enq = 1
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■

Add the following line:
enque/serverinst = 42

■

Change the value of PORT in the following line:
ms/server_port_0 = PROT=HTTP, PORT=8142

6

In the XI1_ASCS42_SAPXI1ASCS profile, do the following:
■

■

Change the values of the following parameters:
SAPGLOBALHOST

SAPXI1ASCS

SAPLOCALHOST

SAPXI1ASCS

INSTANCE_NAME

ASCS42

SAPSYSTEM

42

DIR_EXECUTABLE

C:\usr\sap\XI1\ASCS42\exe

DIR_GLOBAL

C:\usr\sap\XI1\SYS\global

DIR_PROFILE

C:\usr\sap\XI1\SYS\profile

DIR_CT_RUN

C:\usr\sap\XI1\SYS\exe\runU

Remove the following lines:
rdisp/wp_no_dia = 2
rdisp/wp_no_btc = 2
rdisp/wp_no_vb = 1
rdisp/wp_no_vb2 = 1
rdisp/wp_no_enq = 1
rdisp/wp_no_spo = 1
PHYS_MEMSIZE = 512
DIR_TRANS = C:\usr\sap\trans
rdisp/start_icman = TRUE
icm/server_port_0 = PROT=HTTP,PORT=8041
exe/j2ee = $(DIR_INSTANCE)/j2ee/os_libs/jcontrol.exe
rdisp/j2ee_start_control = 1
rdisp/j2ee_start = 1
rdisp/j2ee_timeout = 600
rdisp/frfc_fallback = on
icm/HTTP/j2ee_0 = PREFIX=/,HOST=localhost,CONN=0-500,PORT=54100
jstartup/trimming_properties = off
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jstartup/protocol = on
exe/jlaunch = $(DIR_INSTANCE)/j2ee/os_libs/jlaunch.exe
jstartup/vm/home = C:\Program Files\j2sdk1.4.2_10
INSTANCE_PROPERTIES =
$(DIR_INSTANCE)/j2ee/cluster/instance.properties
SDM_PROPERTIES = $(DIR_INSTANCE)/SDM/program/config/
sdm_jstartup.properties
jstartup/instance_properties =
$(INSTANCE_PROPERTIES);$(SDM_PROPERTIES)
ms/server_port_0 = PROT=HTTP, PORT=8141
■

Add the following lines:
rdisp/msserv = 3642
enque/table_size = 4096
enque/deque_wait_answer = FALSE
enque/serverinst = 42
enque/process_location = LOCAL
enque/encni/port = 3242
rdisp/myname = SAPXI1ASCS_XI1_42
rdisp/enqname = $(rdisp/myname)
enque/snapshot_pck_ids = 100
ms/server_port_0 = PROT=HTTP, PORT=8142
enque/server/threadcount = 1
ipc/shm_psize_34 = 0

7

In the DEFAULT.PFL file, do the following:
■

Make SAPDBHOST equal to SAPNWDB, the virtual host name of the
database server.

■

Change the value of PORT in this line.
ms/server_port_0= PROT=HTTP, PORT=8142

■

Add the following lines:
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enque/process_location= REMOTESA
enque/serverhost= SAPXI1ASCS
enque/serverinst= 42

8

Go to the following services file, and change the value of the message server
port for the sapmsXI1 service to 3642/tcp:
Windows 2003

c:\WINDOWS\system32\drivers\etc\services

Windows 2008

C:\WINDOWS\system32\drivers\etc\services

The Java Add-In Enqueue server instance is configured and is ready for
clustering.
See “Clustering an SAP instance” on page 62.

Installing and configuring an SAP Add-In Enqueue Replication server
Perform the following instructions to install and configure an SAP Add-In Enqueue
Replication server for an ABAP system.
See “Installing an SAP Enqueue Replication server” on page 58.
Perform the following instructions to install and configure an SAP Add-In Enqueue
Replication server for a Java System.
See “Installing an SAP Enqueue Replication server” on page 58.

Installing an SAP Enqueue Replication server
For a highly available clustering system, you must configure an Enqueue
Replication server along with a Standalone Enqueue server.
Note: Before configuring the Enqueue Replication server, refer to SAP Note
1018968.
Before installing an Enqueue Replication server, install the Standalone Enqueue
server depending on the type of system as follows:
■

For an SAP ABAP system
See “Installing an SAP ABAP Standalone Enqueue server” on page 39.

■

For an SAP Add-In system
See “Installing an SAP Add-In Standalone Enqueue server” on page 52.

■

For an SAP Java system, you must install an SAP Java Central Services instance
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See “Installing an SAP Java Central Services instance” on page 45.
Before you install the SAP Enqueue Replication Server, assume the following:
■

The value of the SAPSID attribute is <sapsid>.

■

The virtual hostname of the Standalone Enqueue server is <enq_server>.
For an SAP Java system, consider <enq_server> as the SAP Java Central Services
instance.

■

The virtual hostname of the Enqueue Replication server is <rep_server>.

■

The instance number of the Standalone Enqueue server is <xx>.
For an SAP Java system, consider <xx> as the instance number of the SAP Java
Central Services instance.

■

The instance number of the Enqueue Replication server is <yy>.
Ensure that the instance numbers for the shared memory segments of the
Standalone Enqueue server and the Enqueue Replication server are the same.
Incase of a Standalone Enqueue server failure, this similarity facilitates the
Enqueue lock table takeover.

To install and configure an SAP Enqueue Replication Server

1

Add the following line in the <sapsid>_(A)SCS<xx>_<enq_server> profile:
enque/server/replication = true

Restart the (A)SCS<xx> instance for the changes to take effect.

2

Make a copy of the START_(A)SCS<xx>_<enq_server> start profile, and
rename the copy as START_REP<yy>_<rep_server>. This profile is the start
profile for the Enqueue Replication server instance.

3

In the START_REP<yy>_<rep_server> profile, do the following:
■

Change the values of the following parameters.
SAPSYSTEM

<yy>

SCSID

<xx>

INSTANCE_NAME

REP<yy>

SAPGLOBALHOST

<enq_server>

SAPLOCALHOST

<rep_server>

DIR_INSTANCE

<drive>:\usr\sap\<sapsid>\INSTANCE_NAME

DIR_EXECUTABLE

<drive>:\usr\sap\<sapsid>\INSTANCE_NAME\exe
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■

DIR_LIBRARY

<drive>:\usr\sap\<sapsid>\INSTANCE_NAME\exe

DIR_PROFILE

\\<enq_server>\sapmnt\<sapsid>\SYS\profile

DIR_GLOBAL

\\<enq_server>\sapmnt\<sapsid>\SYS\global

Remove the following lines:
_CP = sapcpe.exe
Start_Program_00 = immediate $(DIR_EXECUTABLE)\$(_CP)
pf=$(DIR_PROFILE)\<sapsid>_(A)SCS<xx>_<enq_server>
_MS=msg_server.exe
Start_Program_01=local $(DIR_EXECUTABLE)\$(_MS)
pf=$(DIR_PROFILE)\<sapsid>_(A)SCS<xx>_<enq_server>
_EN = enserver.exe
Start_Program_02 = local $(DIR_EXECUTABLE)\$(_EN)
pf=$(DIR_PROFILE)\<sapsid>_(A)SCS<xx>_<enq_server>

■

Add the following lines:
_CP = sapcpe.exe
Start_Program_00 = immediate $(DIR_EXECUTABLE)\$(_CP)
pf=$(DIR_PROFILE)\<sapsid>_REP<yy>_<rep_server>
_ER = enrepserver.exe
Start_Program_01 = local $(DIR_EXECUTABLE)\$(_ER)
pf=$(DIR_PROFILE)\<sapsid>_REP<yy>_<rep_server> NR=$(SCSID)

4

Make a copy of the <sapsid>_(A)SCS<xx>_<enq_server> instance profile, and
rename the copy as <sapsid>_REP<yy>_<rep_server>. This profile is the
instance profile for the Enqueue Replication server instance.

5

In the <sapsid>_REP<yy>_<rep_server> profile, do the following:
■

Change the values of the following parameters:
SAPSYSTEM

<yy>

SCSID

<xx>

INSTANCE_NAME

REP<yy>

DIR_GLOBAL

\\<enq_server>\sapmnt\<sapsid>\SYS\global

DIR_PROFILE

\\<enq_server>\sapmnt\<sapsid>\SYS\profile

DIR_EXECUTABLE

<drive>:\usr\sap\<sapsid>\REP<yy>\exe
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■

DIR_CT_RUN

\\<enq_server>\sapmnt\<sapsid>\SYS\exe\run

SAPGLOBALHOST

<enq_server>

SAPLOCALHOST

<rep_server>

SAPLOCALHOSTFULL

<rep_server>

Remove the following lines:
rdisp/myname = <enq_server>_<sapsid>_<xx>
enque/server/replication = true
enque/server/threadcount = 1
ipc/shm_psize_34 = 0
enque/table_size = 4096
enque/deque_wait_answer = FALSE
enque/process_location = LOCAL
enque/encni/port = 3210
rdisp/enqname = $(rdisp/myname)
enque/snapshot_pck_ids = 100
rdisp/mshost=<enq_server>
rdisp/msserv = 3610
ms/server_port_0=PROT=HTTP, PORT=8110

■

Add the following lines:
enque/process_location = REMOTESA
enque/serverhost = <enq_server>
enque/serverport = 32$(SCSID)
enque/serverinst = $(SCSID)
enque/enrep/poll_interval = 0
enque/enrep/poll_timeout = 120
enque/enrep/inactive_action = sleep

6

Create the following directory structure:
<drive>:\usr\sap\<sapsid>\REP<yy>\exe
<drive>:\usr\sap\<sapsid>\REP<yy>\log
<drive>:\usr\sap\<sapsid>\REP<yy>\data
<drive>:\usr\sap\<sapsid>\REP<yy>\work

7

From the (A)SCS instance directory, copy all binaries into the
<drive>:\usr\sap\<sapsid>\REP<yy>\exe directory.
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8

In the <drive>:\usr\sap\<sapsid>\REP<yy>\exe directory, create an sapcpe.exe
list file. Name the list file as rep.lst.
The rep.lst file must contain the names of all the binary files in this directory.
The list file must also include an entry as rep.lst.

9

Use the sapstartsrv.exe command to create an SAP Windows Service for the
Enqueue Replication server instance.
Start the SAP instance for the Enqueue Replication server. Ensure that the
instance is running successfully.
The SAP instance is now ready for clustering.
See “Clustering an SAP instance” on page 62.

Clustering an SAP instance
This section describes the procedure for clustering an SAP instance.
This procedure involves the following steps:
■

Install the appropriate Windows Resource kit.

■

Add the %WINDIR%\SapCluster directory to the path variable of the user
sapsidadm.
In an SAP cluster installation, an additional directory, %WINDIR%\SapCluster,
is created under the system directory. This directory contains all the SAP files
that the cluster nodes require. These files are database tools and program files
that the operating system monitors and SAPOsCol uses. They are independent
of the node that the SAP instance is running on.

■

Configure the node that hosts the SAP Central Service Instance ([A]SCS) or
Central Instance based on SAPGLOBALHOST parameter, and then configure
all other nodes that you want to cluster.

Configuring the first node in the cluster
On the node in the cluster on which you installed SAP the first time, you must
perform the following steps:
■

Copy the required tools in to the SAPCluster directory.

■

Set the SAPService to manual.

■

Ensure that the SAPOsCol service is started from the SAPCluster directory.

■

Create the cluster service group for SAP instance.

These steps are explained in detail in the following sections.
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To configure the first node in the cluster

1

Stop the SAP Central Services Instance or the Central instance based on
SAPGLOBALHOST.

2

Add the following lines in the start and instance profiles of the Central
instance:
DIR_INSTALL = <DISK>:\usr\sap\SID\SYS
DIR_INSTANCE = <DISK>:\usr\sap\<SAPSID>\<InstName>
SAPLOCALHOST = <InstanceVirtualHostName>
SAPLOCALHOSTFULL = <InstanceVirtualHostName>

3

In the start profile, make AUTOSTART as equal to 0.

4

Create the following directory:
%windir%\SapCluster

5

From the <disk>:\usr\sap\<SAPSID>\<InstName>\exe directory, copy the
following files into the %windir%\SapCluster directory:
sapevents.dll
sapntchk.exe
saposcol.exe
sapstartsrv.exe

6

7

Change the <sapsid>adm user environment as follows:
■

At the command prompt, type runas /profile
/user:<domain>\<sapsid>adm regedit.

■

In the Registry Editor screen, click HKEY_CURRENT_USER >
Environment.

■

Change the value of PATH to %PATH%;%windir%\SapCluster.

Stop the following SAP services:
saposcol
SAP<SAPSID>_<No.>

8

Change the SAP service configuration by running the following command
from the command prompt:
sc config saposcol binPath= "%windir%\SapCluster\saposcol
service"
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9

Configure the SAP<SAPSID>_<No.> service as follows:
■

At the command prompt, go to the %windir%\SapCluster\ directory.

■

Run the sapstartsrv.exe command.

■

In the SAP Service Install/Uninstall dialog box, select Register COM
Typelibrary only in the Operation field.

■

Click OK.

■

Click Start > Run.

■

Enter services.msc in the Open field.

■

In the Services dialog box, right-click the SAP<SAPSID>_<No.> service,
and select Properties.

■

Select Manual in the Startup type field.

■

Click OK.

■

Quit the Services dialog box.

10 Create the following registry keys:
■

At the command prompt, type runas /profile
/user:<domain>\<sapsid>adm regedit.

■

In the Registry Editor screen, click HKEY_LOCAL_MACHINE > System
> CurrentControlSet > Services > EventLog > Application.

■

Create registry keys, SAPOsCol and SAP<SAPSID>_<No.>.

■

Assign the following values to the registry entries of SAPOsCol and
SAP<SAPSID>_<No.>:
TypesSupported

Type: REG_DWORD
Data: 7

EventMessageFile

Type: REG_EXPAND_SZ
Data: %windir%\SapCluster\SAPEVENTS.DLL

Configuring all other nodes in the cluster
Activities on all other nodes in the cluster involve the following steps:
■

Create required users and groups.

■

Copy the required tools in the SAPCluster directory.
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■

Set the system and user environment.

■

Enter the required port numbers in the Windows services files.

■

Create the SAPService and SAPOsCol services.

These steps are explained in detail in the following procedure.
To configure all other nodes in the cluster

1

Create local groups, SAP_<SAPSID>_LocalAdmin and SAP_LocalAdmin.

2

Add the SAP_<SAPSID>_GlobalAdmin domain group to these local groups.

3

Add the SAP_<SAPSID>_GlobalAdmin domain group to the local
Administrators group.
For details about creating and adding new local groups and users:
See “Creating and adding local groups and users” on page 72.

4

Click Start > Programs > Administrative Tools > Local Security Policy >
Local Policies > User Right Assignment.

5

Add the following privileges for the <sapsid>adm user.
Act as a part of the Operating System (SeTcbPrivilege)
Replace a process-level token (SeAssignPrimaryTokenPrivilege)
Adjust memory quotas for a process for Windows Server 2003
(SeIncreaseQuotaPrivilege)

6

Add the following privileges for the SAPService<SAPSID> user.
Log on as a Service (SeServiceLogonRight )
Access this computer from the network (SeNetworkLogonRight)
Deny Logon Locally and Deny Log on through Terminal Services
(SeDenyInteractiveLogOnRight)

7

Change the <sapsid>adm user environment as follows:
■

At the command prompt, enter runas /profile
/user:<domain>\<sapsid>adm regedit.

■

In the Registry Editor dialog box, click HKEY_CURRENT_USER >
Environment.

■

Create the user environment.
See “Configuring the first node in the cluster” on page 62.
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8

From the first node in the cluster, copy the following service entries for the
SAP instance, from the services file in the %windir%\system32\drivers\etc
directory to the corresponding services file on all other nodes in the cluster:
sapdp<No.>
32<No.>/tcp # SAP System Dispatcher Port
sapdp<No.>s
47<No.>/tcp # SAP System Dispatcher Security Port
sapgw<No.>
33<No.>/tcp # SAP System Gateway Port
sapgw<No.>s
48<No.>/tcp # SAP System Gateway Security Port
sapms<SAPSID> 36<No.>/tcp # SAP System Message Port

Typically, the value of <No.> is the value of InstID.

9

Move the Service Group from the first node to the node that you are currently
configuring.

10 Create the following directory:
%windir%\SapCluster

11 From the <disk>:\usr\sap\<SAPSID>\<InstName>\exe directory, copy these
files into the %windir%\SapCluster directory.
sapevents.dll
sapntchk.exe
saposcol.exe
sapstartsrv.exe

12 Ensure that the <drive>:\usr\sap directory is shared with the names, sapmnt
and saploc.
See “Converting a local installation into a domain installation” on page 31.

13 Create the saposcol service by running the following command at the
command prompt:
sc create saposcol binPath= "%windir%\SapCluster\saposcol
service" start= auto obj= <domain>\SAPService<SAPSID> password=
<password_of_SAPService<SAPSID>> [DisplayName= SAPOsCol]

14 Create the SAP<SAPSID>_<No.> service as follows:
■

At the command prompt, go to the
<drive>:\usr\sap\<SAPSID>\<InstName>\exe directory.

■

Run the sapstartsrv.exe command.

■

In the SAP Service Install/Uninstall dialog box, enter the following values:
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SID

<SAPSID>

NR

<InstanceNumber>

StartProfile

If SAPLOCALHOST=SAPGLOBALHOST, the value
is
<drive>:\usr\sap\<SAPSID>\profile\START_
<InstName>_<VirtualHostName>
Else, the value is
\\SAPGLOBALHOST\sapmnt\<SAPSID>\SYS\
profile\START_<InstName>_<VirtualHostName>

■

User

<domain>\SAPService<SAPSID>

Password

<SAPService<SAPSID> password>

Startup type

manual

Use Environment of User

<domain>\<sapsid>adm

Click OK.

15 Reregister type library as follows:
■

At the command prompt, go to the %windir%\SapCluster directory.

■

Run the sapstartsrv.exe command.

■

In the SAP Service Install/Uninstall dialog box, select Register COM
Typelibrary Only in the Operation field.

■

Click OK.

16 Create registry entries for the SAP<SAPSID>_<No.> and saposcol services.
See “Configuring the first node in the cluster” on page 62.

17 If an SAP Microsoft Management Console (MMC) is not configured on the
node, register SAP MMC using the following steps:
■

Access the <DVD>:\SAPINST\NT\<platform>\MMC directory.
For SAP NetWeaver 04s, access the presentation DVD and go to the
\SAPINST\NT\<platform>\MMC directory.

■

Extract the SAPMMCU.SAR (Unicode) archive.
sapcar -xvf
"<DVD>:\SAPINST\NT\<platform>\MMC\SAPMMCU.SAR"

■

Copy the extracted files to the %windir%\system32 directory.
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If you are unable to copy librfc32u.dll, stop the SAP<SAPSID>_<No.>
service, and try again.
■

Register all sapmmc*.dlls at the command prompt using this command
for each file.
%windir%\system32\regsvr32 <dll_file_name>

■

Create a desktop shortcut for %windir%\system32\sapmmc.msc.

Clustering an SAP Add-In instance
Note: This section is not applicable for SAP NetWeaver 04s.
For an SAP Add-In system, clustering the Central instance and the Enqueue servers
in different Service Groups is not possible. The path names and virtual hostnames
are firmly connected to various points in the J2EE engine and therefore, you must
not change the instance names and the virtual hostnames.
But when you cluster the Central instance and the Enqueue servers in the same
Service Group, the down time increases whenever the Enqueue server fails. This
increase is because the Central instance takes more time to shut down or restart.
Another drawback is that whenever the Enqueue server fails, all user sessions
connected to the Central instance are lost.
To resolve this issue, configure the Central instance outside the cluster
environment. If you want to conduct SDM deployment tasks, bring the Central
instance online manually, on the same node on which the Service Group including
the Enqueue servers is online. For all user operations, you can additionally install
and use a dedicated Dialog instance.
Note: If you are clustering the Central instance, Symantec recommends that you
cluster the Central instance, Java Central Services instance, and ABAP Standalone
Enqueue server instance in the same Service Group. Symantec also recommends
that you cluster the Enqueue Replication servers for ABAP and Java for an Add-In
system in a single Service Group. Such a high availability configuration facilitates
failover to another node in the cluster if a fault occurs.
For clustering this instance:
See “Clustering an SAP instance” on page 62.
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Creating and adding domain groups and users
If you do not have domain administrator rights, you can perform the SAP instance
installation and configuration as a domain user who is a member of the local
administrator group.

User accounts
The SAPInst tool creates the following accounts for the SAP system administrator:
<sapsid>adm

This user account is the SAP system administrator account. This
account enables interactive administration of the system.

SAPService<SID>

This user account is required to start the SAP system. This account
has the local user right to log on as a service.
The advantage of setting up this additional account is that this
account does not allow interactive logon. Therefore, abuse of the
account can be prevented. You need not set an expiry date for the
password and you can skip selecting the User must change
password at next logon option.

Groups
The SAPInst tool creates the following groups during domain installation:
■

SAP_<SAPSID>_GlobalAdmin
This global group is a domain level SAP administration group for organizing
SAP system administrators. This global group groups together the users at
the domain level so that they can be placed in appropriate local groups.

■

SAP_<SAPSID>_LocalAdmin
Local groups are created and maintained on an application server. A local
group has rights only to the system on which the group is located.
The system on which the local group is located is part of a particular domain.
The local group can contain users and global groups from this domain.

■

SAP_LocalAdmin
Though this group is created on all hosts, creating this group on the transport
host is necessary. Members of this group have full control over the transport
directory, \usr\sap\trans. This directory allows transports to take place between
systems.
The SAP_<SAPSID>_GlobalAdmin groups of all the SAP systems that are part
of the transport infrastructure are added to the SAP_LocalAdmin group.
Therefore, the <sapsid>adm and SAPService<SAPSID> users of all systems in
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the transport infrastructure are members of the SAP_LocalAdmin group. These
users have the rights necessary to initiate and execute transports.

Adding groups
This section describes the procedure to add new domain groups and users. You
can perform this procedure as a domain administrator only.
To create the SAP_<SAPSID>_GlobalAdmin Global group

1

Log in as a domain administrator.

2

Click Start > Programs > Administrative Tools > Active Directory Users
and Computers.
If you are unable to find the following options:
■

Click Start > Run.

■

Enter mmc in the Open field.

■

In the Console window, click File > Add/Remove Snap-in.

■

In the Add/Remove Snap-in dialog box, click Add.

■

In the Add Standalone Snap-in dialog box, select Active Directory Users
and Computers.

■

Click Add.

■

Click OK.

3

In the Active Directory Users and Computers dialog box, right-click Users,
and select New > Group.

4

In the New Object - Group dialog box, enter the following values:
Group Name

SAP_<SAPSID>_GlobalAdmin
Specify this value using the exact and correct uppercase and
lowercase.

5

Group scope

Global

Group type

Security

Click OK.

Installing and configuring the SAP NetWeaver for high availability
Creating and adding domain groups and users

To create SAP system users, <sapsid>adm and SAPService<SAPSID>

1

In the Active Directory Users and Computers dialog box, right-click Users,
and select New > User.

2

In the New Object - User dialog box, enter the following values for
<sapsid>adm:

3

First name

NA

Initials

NA

Last name

NA

Full name

<sapsid>adm

User logon name

<sapsid>adm

In the New Object - User dialog box, enter the following values for
SAPService<SAPSID>:
First name

NA

Initials

NA

Last name

NA

Full name

SAPService<SAPSID>

User logon name

SAPService<SAPSID>

4

Click Next.

5

Enter the password and confirm the password.

6

Select Password never expires.
Ensure that no other option is selected.

7

Click Next.

8

Click Finish.

To add the <sapsid>adm user to the SAP_<SAPSID>_GlobalAdmin Group

1

In the Active Directory Users and Computers dialog box, double-click
<sapsid>adm under Users.

2

In the <sapsid>adm Properties dialog box, click Member > Add.

3

In the Select Groups dialog box, select SAP_<SAPSID>_GlobalAdmin.
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4

Click Add.
By default, this user is also a member of the Domain Users group.

5

Click OK twice.

To add the SAPService<SAPSID> user to the SAP_<SAPSID>_GlobalAdmin Group

1

In the Active Directory Users and Computers dialog box, double-click
SAPService<SAPSID> under Users.

2

In the SAPService<SAPSID> dialog box, click Member > Add.

3

In the Select Groups dialog box, select SAP_<SAPSID>_GlobalAdmin.

4

Click Add. SAP_<SAPSID>_GlobalAdmin appears in the Member of list.

5

This user must not be a member of the Domain Users group.
Remove the user from the Domain Users group as follows:
■

From the Member of list, select SAP_<SAPSID>_GlobalAdmin.

■

Select Set Primary Group.

■

Select Domain Users.

■

Click Remove to delete the Domain Users group from the Member of list.

6

Click OK.

7

Exit the Active Directory Users and Computers dialog box.

Creating and adding local groups and users
This section describes the procedure to add new local groups and users.
Assume that you are adding a local group, SAP_<SAPSID>_LocalAdmin.
To create a local group

1

Click Start > Control Panel > Administrative tools > Computer Management.

2

In the Computer Management dialog box, select Local Users and Groups.

3

Right-click Group, and select New Group.

4

In the New Group dialog box, enter SAP_<SAPSID>_LocalAdmin in the Group
name field.

5

Click Add.

6

In the Select Users, Computers, or Groups dialog box, enter
<domain>\SAP_<SAPSID>_GlobalAdmin in the Object names field.
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7

Click OK in the Select Users, Computers, or Groups dialog box.
SAP_<SAPSID>_LocalAdmin appears in the New Group dialog box.

8

Click OK in the New Group dialog box.

To add a domain group to a local group

1

Click Start > Control Panel > Administrative tools > Computer Management.
Assume that you are adding the domain group, SAP_<SAPSID>_GlobalAdmin
to the local Administrators group.

2

In the Computer Management Console, select Local Users and Groups >
Groups.

3

In the right panel, double-click Administrators.

4

In the Administrators Properties dialog box, click Add.

5

In the Select Users, Computers, or Groups dialog box, enter
<domain>\SAP_<SAPSID>_GlobalAdmin in the Object names field.

6

Click OK in the Select Users, Computers, or Groups dialog box.

7

Click OK in the Administrators Properties dialog box.

Creating sapmnt and saploc share directories
Ensure that the sapmnt and saploc directories are shared, and are accessible by
the SAP system Administrator.
To create the sapmnt and saploc share directories on Windows Server 2003

1

Right-click the drive:\usr\sap directory, and select Properties.

2

In the Properties dialog box, click the Sharing tab.

3

Click Share this folder.

4

Enter sapmnt in the Share name field.

5

Click Permissions.

6

In the Permissions for sapmnt dialog box, ensure that the Administrators
and SAP_LocalAdmin user groups have full control for the sapmnt directory.

7

Click OK in the Permissions for sapmnt dialog box.

8

In the Properties dialog box, click New Share.

9

In the New Share dialog box, enter saploc in the Share name field.

10 Click OK in the New Share dialog box.
11 Click Permissions.
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12 In the Permissions for saploc dialog box, ensure that the Administrators and
SAP_LocalAdmin user groups have full control for the saploc directory.

13 Click OK in the Permissions for saploc dialog box.
14 Click OK in the Properties dialog box.
To create the sapmnt and saploc share directories on Windows Server 2008

1

Right-click the drive:\usr\sap directory, and select properties.

2

On the Properties dialog box, click the Sharing tab.

3

Click Advanced Sharing.

4

Select Share this folder option.

5

Enter sapmnt in the Share name field.

6

Click Permissions.

7

In the Permissions for sapmnt dialog box, ensure that the Administrators
and SAP_LocalAdmin user groups have full control for the sapmnt directory.

8

Click OK in the Permissions for sapmnt dialog box.

9

In the Properties dialog box, click Advanced Sharing.

10 On the Advanced Sharing dialog box, click Add.
11 On the New Share dialog box, enter saploc in the Share name field.
12 Click OK in the New Share dialog box.
13 Click Permissions.
14 In the Permissions for saploc dialog box, ensure that the Administrators and
SAP_LocalAdmin user groups have full control for the saploc directory.

15 Click OK in the Permissions for saploc dialog box.
16 Click OK in the New Share dialog box.
17 Click OK in the Advanced Sharing dialog box.
18 Click Close in the Properties dialog box.

Configuring the SAP systems on Windows Server 2008
The File Share feature functions differently on Windows Server 2008, as compared
to Windows Server 2003. On Windows Server 2008, you can only access file shares
pointing to local disks with the physical computer name. To be able to define file
shares pointing to shared disks, a “client access point” (one IP address associated
with one network name cluster resource) must already exist in the failover cluster
service group to which the shared disk belongs. Since you can only access file

Installing and configuring the SAP NetWeaver for high availability
Configuring the SAP systems on Windows Server 2008

shares pointing to shared disks with the network name that belongs to the same
failover cluster service group, you can create multiple file shares with the same
file share name (for example, sapmnt) in a failover cluster environment, assuming
the file shares belong to different cluster service groups.
Figure 2-1 shows a typical SAP system installation on a Windows Server 2008
system under VCS environment.
Figure 2-1

Typical SAP system installation (using multiple sapmnt file shares)
on a Windows Server 2008 system under VCS environment

For sample service group configurations on Windows Server 2008,
See “Sample service group configurations for SAP system on Windows Server
2008” on page 123.
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Chapter

3

Installing, upgrading, and
removing the agent for SAP
NetWeaver
This chapter includes the following topics:
■

Before you install the agent for SAP NetWeaver

■

Installing the VCS agent for SAP NetWeaver

■

Removing the VCS agent for SAP NetWeaver

■

Upgrading the agent for SAP NetWeaver

Before you install the agent for SAP NetWeaver
You must install the agent on all the systems that will host an SAP Service Group.
Ensure that you meet the following prerequisites before installing the agent for
SAP NetWeaver:
■

Install and configure Veritas Cluster Server.

■

Remove any previous version of this agent.
See “Removing the VCS agent for SAP NetWeaver” on page 79.

Installing the VCS agent for SAP NetWeaver
Use the Product Installer to install the agent for SAP NetWeaver.
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Note: Ensure that you have uninstalled the previous version of this agent, if
installed.
Also note that the agents for both, SAP NetWeaver and SAP WebAS are combined
in a single package. Thus, if you install either of the agent, the other agent gets
installed by default.
To install the VCS agent for SAP NetWeaver

1

Log on to any node in the cluster.
Ensure that the logged on user has the domain administrative privileges.

2

Download the complete agent pack tarball from FileConnect site:
https://fileconnect.symantec.com/
Alternatively,
Download the individual agent tarball from the Symantec Veritas Operations
Services (VOS) site:
https://vos.symantec.com/home

3

Uncompress the file to a temporary location.

4

If you downloaded the complete Agent Pack tarball, navigate to the directory
containing the package for the platform running in your environment.

5

Windows 2003
(IA64)

cd1/windows/w2k3IA64/vcs/application/
sapnw_agent/vcs_version/version_agent

Windows 2003
(x64)

cd1/windows/w2k3x64/vcs/application/
sapnw_agent/vcs_version/version_agent

Windows 2008
(x64)

cd1/windows/w2k8x64/vcs/application/
sapnw_agent/vcs_version/version_agent

Double-click the Setup.exe file to begin the installation.
You may see a pkgs directory here. Do not start the installation by executing
the vrtsvcssap.msi file in this directory.

6

On the Veritas Product Installer screen, click Veritas High Availability
Agents 5.0.2.0 for SAP NetWeaver.

7

On the Welcome screen, click Next.

8

On the Computer Selection dialog box, in the Computer field, enter the node
name on which you want to install the agents for SAP NetWeaver.
Alternatively,
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9

■

Browse to select the nodes from the domain in which you want to install
the agents for SAP NetWeaver. Select the nodes and click OK.

■

Click Add.

■

Click Next.

On the Validation screen, view the installation status on each of the selected
node and click Next.
Note: An error is displayed, if you have a previous version of this agent
installed.

10 On the Report screen review the summary report and click Install.
The installer displays the installation status during and after the installation.

11 On the Install Summary screen, click Next.
12 On the Final screen, click Finish.
13 On the Veritas Product Installer screen, click Exit to exit the installer.

Removing the VCS agent for SAP NetWeaver
Perform the following procedure to uninstall the agent for SAP NetWeaver from
a cluster. Perform these steps while the cluster is active.
Note: The agent for SAP NetWeaver and SAP WebAS are combined in a single
package. Thus, removing one agent package will remove the other by default.
To uninstall the VCS agent for SAP NetWeaver

1

Ensure that all clustered SAP resources are offline.

2

From the cluster, remove all the resources that use the agents for SAP
NetWeaver.

3

Perform the following steps on each node from which you want to uninstall
the agent. Ensure that you have a user with administrative privileges.
■

Click Start > Settings > Control Panel.

■

Double-click Add/Remove Programs.

■

From the list of programs, select Veritas High Availability Agents 5.0.2.0
for SAP NetWeaver.
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4

Click Change/Remove.

5

Follow the instructions that the uninstall program provides, to complete the
uninstallation of the agents for SAP NetWeaver.

Upgrading the agent for SAP NetWeaver
Perform the following steps to upgrade the agent with minimal disruption, in a
VCS environment.
To upgrade the agent in a VCS environment

1

Login as domain administrator.

2

Verify that your path is drive:\Program Files\Veritas\Cluster Server\bin

3

Persistently freeze all the service groups that host the application.
C:\> hagrp –freeze GroupName -persistent

4

Stop the cluster services forcibly.
C:\> hastop -all –force

5

Ensure that the agent operations are stopped on all the nodes.

6

Take a back up of the main.cf and types.cf
C:\> copy drive:\> Program Files\Veritas\Cluster
Server\conf\config\main.cf drive:\>backup\main.cf
C:\> copy drive:\> Program Files\Veritas\Cluster
Server\conf\config\types.cf drive:\>backup\types.cf

7

Uninstall the agent package from all the nodes.
See “Removing the VCS agent for SAP NetWeaver” on page 79.

8

Install the new agent on all the nodes.
See “Installing the VCS agent for SAP NetWeaver” on page 77.

9

Navigate to drive:\> Program Files\Veritas\Cluster Server\conf\config\types.cf
file and verify if any duplicate type definitions exists for Weblogic on all the
nodes.
If duplicate type definitions exist, remove old type definition from types.cf
file and save the file.
Note: To identify the old type definition, compare the new type definition file
with the old (backed up) types.cf file.
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10 Check for the changes in the resource values required, if any, due to the new
agent types definition.
Note: To note the list of changed attributes, compare the new type definition
file with the old type definition file.

11 Start VCS on all nodes in the cluster.
C:\> hastart

12 Start the agent on all nodes, if not started.
C:\> haagent -start SAPNW04 -sys SystemName

Optionally, start the SAPWebAS agent,
C:\> haagent -start SAPWebAS -sys SystemName

13 Unfreeze the service groups once all the resources come to an online steady
state.
C:\> hagrp -unfreeze GroupName -persistent
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Configuring the agent for
SAP NetWeaver
This chapter includes the following topics:
■

About configuring the agent for SAP NetWeaver

■

Agent attributes for SAP NetWeaver

■

Setting the SAPMonHome attribute

■

Configuring the execution period for agent functions

■

Executing a custom monitor program

About configuring the agent for SAP NetWeaver
To provide high availability for SAP components in the VCS environment, you
must first configure the VCS resources of type SAPNW04.
After installing the Agents for SAP NetWeaver, you can create and configure SAP
resources. Before you configure a resource, review the attributes table that
describes the SAPNW04 resource type and its attribute definitions.
See “Agent attributes for SAP NetWeaver” on page 83.

Agent attributes for SAP NetWeaver
Table 4-1 shows the required attributes for configuring an SAP instance.
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Table 4-1

Required Attributes

Required attributes

Description

EnqSrvResName

Name of the VCS resource that is running the Standalone Enqueue server instance
or SAP Central Services. The Enqueue Replication server instance uses this attribute
to query the state of the resource that is running the Standalone Enqueue server
instance, whenever a fault occurs.
The preonline trigger script also uses this attribute in case of a Standalone Enqueue
server fail over. The script uses this attribute to identify the appropriate node on
which the Enqueue Replication server instance is running.
Type and dimension: string-scalar
Default: ""
Example: SAPEC4ASCS_srv

EPProgramTimeout

The amount of time reserved for graceful clean-up activities that the clean operation
performs on an SAP instance, before returning control to the VCS engine.
See “Configuring the execution period for agent functions” on page 90.
Type and dimension: integer-scalar
Default: 10
Example: 20

InstName

Uniquely identifies an SAP server instance, along with the SAPSID attribute. The
last two characters of this attribute specify the value of the InstID attribute. The
InstID and SAPSID attributes together uniquely identify an SAP instance.
Some examples include the following:
■

DVEBMGS00: SAP BASIS Central instance

■

DVBGS02 : SAP BASIS Central instance minus Enqueue and Message servers

■

ASCS03: SAP ABAP Standalone Enqueue server

■

REP04: SAP ABAP Enqueue Replication server

■

D05: SAP ABAP Dialog instance

■

JC06: SAP Java Central instance

■

SCS07: SAP Java Central Services instance

■

J08: SAP Java Dialog instance

■

ERS10: SAP Enqueue Replication server

See “Uniquely identifying SAP server instances” on page 27.
Type and dimension: string-scalar
Example: DVEBMGS00
Default: ""
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Table 4-1

Required Attributes (continued)

Required attributes

Description

InstProfile

Full path to the instance profile of the SAP server instance. SAP Java instances,
Enqueue Replication server instances, and Standalone Enqueue server instances use
this attribute during second-level monitoring.
Typically, the instance profile is located in the <drive>:\usr\sap\SAPSID\SYS\profile
directory. The format of the profile name is SAPSID_InstName_VIRTUAL_HOSTNAME.
Path names following the Unified Naming Convention (UNC) are also valid for this
attribute.
Type and dimension: string-scalar
Default: ""
Example 1: c:\usr\sap\EP1\SYS\profile\EP1_SCS02_SAPEP1SCS
Example 2: \\SAPEP1SCS\sapmnt\EP1\SYS\profile\EP1_REP03_SAPEP1REP
Example 3: \\SAPEP1SCS\sapmnt\EP1\SYS\profile\EP1_JC00_SAPEP1CI

InstType

SAP server instance type. Valid values include the following:
■

CENTRAL: SAP Central instance

■

DIALOG: SAP Dialog instance

■

ENQUEUE: SAP Standalone Enqueue server instance

■

ENQREP: SAP Enqueue Replication server instance

■

AENQUEUE: SAP Standalone Enqueue server instance Add-In (ABAP)

■

AENQREP: SAP Enqueue Replication server instance Add-In (ABAP)

■

JENQUEUE: SAP Central Services instance Add-In (Java)

■

JENQREP: SAP Enqueue Replication server instance Add-In (Java)

Type and dimension: string-scalar
Default: CENTRAL
Example: DIALOG
ProcMon

The list of SAP processes that the monitor function must monitor during a first-level
check of an SAP instance.
See “Monitoring an SAP instance” on page 27.
Type and dimension: vector
Default: ""
Example: disp+work.exe msg_server.exe
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Table 4-1

Required Attributes (continued)

Required attributes

Description

ResLogLevel

The logging detail performed by the Agent for SAP NetWeaver for the resource. Valid
values include the following:
INFO: Logs error messages.
TRACE: Logs error and trace messages. TRACE is very verbose and should only be
used during initial configuration or for troubleshooting and diagnostic operations.
Type and dimension: string-scalar
Default: INFO
Example: TRACE

SAPAdmin

Windows user name used to start the SAP instance. This user must be dedicated to
all the SAP instances within an SAP system. The format is sapsidadm.

Note: Do not include the domain name when specifying this attribute. Use the
SAPAdminDomain attribute to specify domain information.
Type and dimension: string-scalar
Default: ""
Example: ec4adm
SAPAdminDomain

Windows domain name to which the SAPAdmin user belongs.

Note: If SAPAdmin does not belong to a Windows domain, use the cluster localization
settings to specify the local computer name for each system.
Type and dimension: string-scalar
Default: ""
Example: VRTSGPS
SAPAdminPassword

Password for the SAPAdmin user.
Use the vcsencrypt -agent command to encrypt the password. If you are using
the VCS GUI, the GUI automatically encrypts the password.
Type and dimension: string-scalar
Default: ""
Example: vxfgh28skbsj
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Table 4-1

Required Attributes (continued)

Required attributes

Description

SAPHost

Virtual IP host name (LANMAN name) under which the SAP instance is to run.
Type and dimension: string-scalar
Default: ""
Example: sap04smscsaw

SAPHome

The absolute path to the SAP base directory. This attribute is used to locate programs
that the Agent for SAP NetWeaver uses for start, stop, and clean functions.
Type and dimension: string-scalar
Default: ""
Example 1: c:\usr\sap\EC4\SYS\exe\run
Example 2: c:\usr\sap\EC4\ASCS01\exe

SAPMonHome

The directory that defines the location of the sapinfo.exe, jcmon.exe, or ensmon.exe
commands. The agent for SAP NetWeaver uses these commands for second-level
monitoring.
This functionality is not a part of the base SAP installation. Hence, the value of this
attribute may be different from the SAPHome attribute.
See “Setting the SAPMonHome attribute” on page 89.
Type and dimension: string-scalar
Default: ""
Example: C:\usr\sap\sapinfo\rfcsdk\bin

SAPServiceUser

Windows user name used to start the SAP Windows service for an SAPSID. This user
must be dedicated to all the SAP services under one SAP system, and must not be
used by any other SAP service or instance under a different SAP system, even in the
same cluster.

Note: Do not include the domain name in the value for this attribute. Use the
SAPAdminDomain attribute to specify domain information.
Type and dimension: string-scalar
Default: ""
Example: SAPServiceEC4
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Table 4-1

Required Attributes (continued)

Required attributes

Description

SAPSID

SAP system name. This attribute starts with an alphabetic character and is exactly
3 characters in length. Ensure that the alphabetic characters used in this attribute
are in uppercase only. SAPSID is defined during the SAP installation.
See “Uniquely identifying SAP server instances” on page 27.
Type and dimension: string-scalar
Default: ""
Example: EC4

Table 4-2 shows the optional attributes for configuring an SAP instance.
Table 4-2

Optional attributes

Optional attributes

Description

MonitorProgram

The full pathname and command-line arguments for an externally provided monitor
program.
See “Executing a custom monitor program” on page 90.
Type and dimension: string-scalar
Default: ""
Example 1: <drive>:\usr\sap\EC4\ASCS00\work\myMonitor.exe
Example 2: <drive>:\usr\sap\EC4\ASCS00\work\myMonitor.exe arg1 arg2

SecondLevelMonitor

Used to enable second-level monitoring. Second-level monitoring is a deeper, more
thorough state check of the SAP instance. The numeric value specifies how often the
monitoring routines must run. 0 means never run the second-level monitoring
routines, 1 means run routines every monitor interval, 2 means run routines every
second monitor interval, and so on.
Based on the type of installation, the agent uses the SAP supplied sapinfo.exe,
jcmon.exe, or ensmon.exe commands to perform second-level monitoring.

Note: Exercise caution while setting SecondLevelMonitor to large numbers. For
example, if the MonitorInterval is set to 60 seconds and the SecondLevelMonitor is
set to 100, then sapinfo.exe is executed every 100 minutes, which may not be as often
as intended. For maximum flexibility, no upper limit is defined for
SecondLevelMonitor.
Type and dimension: integer-scalar
Default: 0
Example: 1
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Setting the SAPMonHome attribute
The SAPMonHome attribute contains the absolute path to the directory that
contains the binary used for second level monitoring process.
The binaries that are used during second level monitoring for different installation
types and SAP instances are as follows:
■

For ABAP: sapinfo
sapinfo is not a standard binary shipped by SAP with installation media. You
need to download the latest rfcsdk kit from the following site:
http://service.sap.com/swdc -> Support Packages and Patches -> Entry by
Application Group -> Additional Components
For more information on selecting the right RFCSDK for your SAP application,
refer to SAP notes 1005832, 825494 and 413708.
Copy the sapinfo binary and the needed libraries, if any, to SAP Instance specific
directory drive\usr\sap\SAPSID\InstName\exe
Also, ensure that the sapinfo binaries and the libraries are copied to
\\SAPGLOBALHOST\sapmnt\SAPSID\SYS\exe\run and the names of the
binaries and libraries are listed in the instance specific sapcpe binary list.

■

For Java: jcmon

■

For Add-In (ABAP + Java): sapinfo, jcmon

■

For Enqueue and Enqueue Replication Server: ensmon

Table 4-3 shows recommended values for the SAPMonHome attribute.
Table 4-3

Recommended values for SAPMonHome attribute

SAP installation type and instance

Format

Value of the SAPMonHome
attribute

SAP ABAP

Unicode and non-Unicode

drive\usr\sap\SAPSID\SYS\exe\run

Unicode

drive\usr\sap\SAPSID\SYS\exe\run

Unicode and non-Unicode

drive\usr\sap\SAPSID\SYS\exe\run

Unicode and non-Unicode

drive\usr\sap\SAPSID\SYS\exe\runU

For all instances
SAP Java
For all instances
SAP Java Add-In
When InstType is equal to CENTRAL,
DIALOG, AENQUEUE, or AENQREP
SAP Java Add-In
When InstType is equal to JENQUEUE or
JENQREP
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Configuring the execution period for agent functions
An agent function is allocated an execution period using the respective time-out
attributes: OnlineTimeout, OfflineTimeout, MonitorTimeout, and CleanTimeout.
If an agent function executes a program, for example sapinfo.exe, the program
must execute within the allocated execution period. If the program is unable to
execute within the allocated period, the agent function cancels and terminates
the execution of the program.
The agent function requires an allocated time to gracefully exit and terminate a
program. The EPProgramTimeout attribute specifies the period in which the agent
function can cancel a running program.
For example, if EPProgramTimeout is set to 10 and MonitorTimeout is set to 60,
the monitor function cancels a program execution if the program does not complete
within 50 seconds of the start of the monitor function.

Executing a custom monitor program
The monitor function executes a custom monitor program to perform a
user-defined SAP instance server state check.
The monitor function executes the MonitorProgram if the following conditions
are true:
■

The MonitorProgram attribute value is set to a valid executable program.

■

The first level process check indicates that the SAP server instance is online.

■

The SecondLevelMonitor attribute is either set to 0 (false), or
SecondLevelMonitor is set to 1 (true) and the second-level check indicates that
the SAP server instance is online.

This feature allows cluster administrators to define custom programs that can
further determine the state of the SAP server.
The monitor operation interprets the program exit code as follows:
110 or 0

SAP server instance is ONLINE

100 or 1

SAP server instance is OFFLINE

99

SAP server instance is UNKNOWN

Any other value

SAP server instance is UNKNOWN
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To ensure that the custom monitor program is always available to the agent
application, Symantec recommends storing the file in a directory that is available
on an online SAP system.
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Configuring the service
groups for SAP server
This chapter includes the following topics:
■

About configuring service groups for SAP NetWeaver

■

Before configuring the service groups for SAP server

■

Configuring service groups for SAP NetWeaver

■

About the configuration process

■

Configuring the VCS preonline trigger

About configuring service groups for SAP NetWeaver
Configuring the SAP NetWeaver service group involves creating the SAP service
group, its resources, and defining attribute values for the configured resources.
You must have administrator privileges to create and configure a service group.
You can configure the service groups using one of the following:
■

The Cluster Manager (Java console)

■

The command-line

See “Configuring service groups for SAP NetWeaver” on page 94.

Before configuring the service groups for SAP server
Before you configure the SAP server service group, you must perform the following:
■

Verify that VCS is installed and configured on all nodes in the cluster where
you will configure the service group.
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Refer to Veritas Storage Foundation™ and High Availability Solutions
Installation and Upgrade Guide for more information on installing and
configuring VCS.
■

Verify that SAP NetWeaver 7.10 is installed and configured identically on all
nodes in the cluster.
See “About installing SAP NetWeaver for high availability” on page 29.
See “About configuring SAP NetWeaver for high availability” on page 30.

■

Verify that the Veritas agents for SAP NetWeaver is installed on all nodes in
the cluster.
See “Installing the VCS agent for SAP NetWeaver” on page 77.

Configuring service groups for SAP NetWeaver
While setting up a cluster, you must always ensure that the cluster has some spare
capacity to handle the SAP NetWeaver failover scenarios. For example, in case of
a backend database failure, the cluster must be able to run another database
instance in conjunction with other running applications. Review the information
about data protection.
See Veritas Storage Foundation™ and High Availability Solutions Installation and
Upgrade Guide
The cluster should be able to provide application failover by encapsulating the
resources required for an application into a service group. A service group is a
virtualized application that can switch between the cluster nodes. It contains a
set of dependent resources, such as disk groups, disk volumes, file systems, IP
addresses, NIC cards, and dependent application processes. It also includes logic
about the dependencies between the application components.
These service groups should thus be configured such that the cluster can start,
stop, monitor, and switch the service groups between the nodes, depending upon
the server faults or resource faults. An administrator should also be proactively
able to move a service group between cluster nodes to perform preventative
maintenance or apply patches.
Perform the following steps to add a service group for SAP NetWeaver

1

Change the cluster configuration to read/write mode.
C:\> haconf -makerw

2

Create a service group for SAP NetWeaver.
C:\> hagrp -add SAP70-ERPASCS

For more details refer to, Veritas Cluster Server Administrator's Guide
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3

Modify the SystemList attribute for the group, to add systems.
C:\> hagrp -modify SAP70-ERPASCS SystemList vcswin74 0 vcswin75
1

4

Create resources for NIC, IP, Lanman, VMDg and MountV in the service group.
C:\> hares -add SAP70-ERPASCS_nic NIC SAP70-ERPASCS
C:\> hares -add SAP70-ERPASCS_ip IP SAP70-ERPASCS
C:\> hares -add SAP70-ERPASCS_lanman Lanman SAP70-ERPASCS
C:\> hares -add SAP70-ERPASCS_mnt MountV SAP70-ERPASCS
C:\> hares -add SAP70-ERPASCS_vmdg VMDg SAP70-ERPASCS

For more details on creating and modifying resource attributes for NIC, IP,
Lanman, VMDg and MountV refer to, Veritas Cluster Server Bundled Agents
Reference Guide.

5

Create links between the resources.
C:\> hares -link SAP70-ERPASCS_ip SAP70-ERPASCS_nic
C:\> hares -link SAP70-ERPASCS_lanman SAP70-ERPASCS_ip
C:\> hares -link SAP70-ERPASCS_mnt SAP70-ERPASCS_vmdg

6

Create SAPNW04 resource for SAP Netweaver.
C:\> hares -add SAP70-ERPASCS_ascs SAPNW04 SAP70-ERPASCS

Based on the SAP instance you are clustering, modify the resource attributes.
For more information on agent attributes,
See “Agent attributes for SAP NetWeaver” on page 83.

7

Create resource dependencies for SAPNW04 resource.
The SAPNW04 resource depends on the Lanman and MountV resources.
C:\> hares -link SAP70-ERPASCS_ascs SAP70-ERPASCS_lanman
C:\> hares -link SAP70-ERPASCS_ascs SAP70-ERPASCS_mnt
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8

Verify the final resource dependencies for SAP server group.
Group
SAP70-ERPASCS
SAP70-ERPASCS
SAP70-ERPASCS
SAP70-ERPASCS
SAP70-ERPASCS

9

Parent
SAP70-ERPASCS_ascs
SAP70-ERPASCS_ascs
SAP70-ERPASCS_ip
SAP70-ERPASCS_lanman
SAP70-ERPASCS_mnt

Child
SAP70-ERPASCS_lanman
SAP70-ERPASCS_mnt
SAP70-ERPASCS_nic
SAP70-ERPASCS_ip
SAP70-ERPASCS_vmdg

Save the cluster configuration.
C:\> haconf -dump -makero

About the configuration process
While various methods and procedures can be used to install and configure the
service groups in an SAP server, Symantec recommends the following general
process:
■

Allocate shared disk resource for the SAP node
Symantec recommends installing each SAP node to be clustered on a separate,
dedicated shared disk resource (e.g. LUN). Work with the appropriate
administrative group in your organization to obtain a shared disk resource
for the SAP node.

■

Create disk group, volumes, and a file system
A disk group contains volumes and file system (mount resource). All SAP R/3
directories are placed in these volumes.
Create a disk group, volumes, and a file systems using the shared disk resources
allocated for the SAP node.
You can use the Veritas Volume Manager to create the disk group, volumes,
and file system.

Obtaining a dedicated virtual IP address and host name
Obtain a dedicated virtual IP address and host name for the SAP node IP network
configuration. The SAP instance uses this network address and host name
exclusively, and is regardless of the system in the cluster running the instance.
Note: Ensure that you map the virtual IPs in the DNS, or the hosts file on each
system.
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Creating cluster service group and supporting resources
Create a cluster service group that contains the resources supporting the SAP
node. Create appropriate cluster resources.
Create links to place the shared disk and networking objects, that were previously
placed under the cluster control.
Test the Service Group configuration by placing it online.
Figure 5-1 shows a sample service group configuration.
Figure 5-1

EP9_EP9Global
Mount

EP9_EP9JC04
Mount

Sample service group configuration

EP9_EP9Profile
Mount

EP9_EP9SCS0
Mount

Lanman
EP9_lman

IP
EP9_ip

DiskGroup
EP9_dg

NIC
EP9_nic

Installing the software for the SAP instance
See “Setting up SAP systems for clustering” on page 30.
Ensure that SAP runs successfully on all nodes of the cluster before placing the
SAP instance under the cluster control.

Placing the SAP instance under cluster control
After the SAP installation is complete, create a cluster resource using the agent
for SAP NetWeaver.
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Figure 5-2 shows a service group in which the SAP instance is under the cluster
control.
SAP instance under cluster control

Figure 5-2
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Configuring the VCS preonline trigger
The behavior of the SAP Standalone Enqueue and SAP Enqueue Replication servers
in a clustered environment has the following requisites:
■

If a Standalone Enqueue server instance fails, the server must fail over to the
node where the Enqueue Replication server instance is online.
The Standalone Enqueue server instance examines the shared memory, and
locates a replicated copy of the lock state table. The instance uses the replicated
copy to initialize the original lock state table.
After the Standalone Enqueue server instance initiates its internal lock buffer,
the Replication server instance must go down and must switch to another node
in the cluster.

■

If the Enqueue Replication server instance fails, the instance must fail over
to such a node in the cluster that does not have an Enqueue server instance
in ONLINE state.
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To facilitate proper failover behavior, you must configure the VCS preonline
trigger. The VCS preonline trigger calls an external preonline trigger utility,
sapnw04preonline.exe. The initiated preonline trigger performs the steps necessary
for correct failover behavior of the Enqueue servers. The sapnw04preonline.exe
utility is located in the %VCS_HOME%\bin\SAPNW04 directory.
To configure the VCS preonline trigger script, perform the following steps:
Step 1: Navigate to the %VCS_HOME%\bin\Trigger directory.
Step 2: Add the following lines to the preonline file:
If you are configuring the preonline file for the first time, this file may not exist.
You can thus skip this step.
#-------------------------------------------------------------# Start sapnw04 preonline trigger.
#-------------------------------------------------------------# Perl preonline.pl <system> <group> <whyonlining>
<systemwheregroupfaulted>
my $system = $ARGV[0];
my $group = $ARGV[1];
my $whyonlining = $ARGV[2];
my $systemwheregroupfaulted = undef;
my $sArgs = join(' ', @ARGV);
VCSAG_LOG_MSG("I", "Arguments [$sArgs]", 15041);
if(defined $ARGV[3]) {
$systemwheregroupfaulted = $ARGV[3];
}
$SAPPreOnlineTrigger =
sprintf("%s\\bin\\SAPNW04\\sapnw04preonline.exe", $vcs_home);
VCSAG_LOG_MSG("I", "The trigger command is
[$SAPPreOnlineTrigger]", 15041);
if(defined $systemwheregroupfaulted)
{
VCSAG_LOG_MSG("I", "The group is faulted on syetem =
[$systemwheregroupfaulted]", 15042);
$CMD = sprintf("\"%s\" %s %s %s %s", $SAPPreOnlineTrigger,
$system, $group, $whyonlining, $systemwheregroupfaulted);
}
else {
$CMD = sprintf("\"%s\" %s %s %s", $SAPPreOnlineTrigger, $system,
$group, $whyonlining);
}
system($CMD);
my $exit_value = $? >> 8;
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VCSAG_LOG_MSG("I", "The exit code from the trigger:
[$exit_value].", 15046, $exit_value);
if($exit_value == 0) {
VCSAG_LOG_MSG("I", "The PreOnline Trigger for SAP excuted
succesfully.", 15046);
exit;}elsif($exit_value == 1) {
VCSAG_LOG_MSG("I", "The PreOnline Trigger for SAP FAILED.",
15047);
exit;
}
else {
VCSAG_LOG_MSG("I", "Unknown PreOnline trigger.", 15048);
}
#-------------------------------------------------------------# End sapnw04 preonline trigger.
#-------------------------------------------------------------.
.
# give control back to HAD.
if (defined $ARGV[3]) {
‘\"$vcs_home\\bin\\hagrp\" -online -nopre $ARGV[1] -sys
$ARGV[0] -checkpartial $ARGV[3]‘;
exit;
}
‘\"$vcs_home\\bin\\hagrp\" -online -nopre $ARGV[1] -sys
$ARGV[0]‘;
exit;

Step 3: If the preonline file does not exist, copy the sample preonline trigger file
from the %VCS_HOME%\bin\Sample_Triggers directory, in to the
%VCS_HOME%\bin\Triggers directory. Revert back to step 2 to step to make
changes in the preonline file.
A sample_sapnw04preonline file is also available in the
%VCS_HOME%\bin\Sample_Triggers directory. You can copy this file in the
%VCS_HOME%\bin\Triggers directory, rename the file to preonline, and use this
file.
Step 4: Set the preonline trigger attribute to true for the Service Groups to which
the Standalone Enqueue server and Enqueue Replication server instances belong.
C:\> hagrp -modify service_group PreOnline 1

For VCS 5.1 and later
C:\> hagrp -modify service_group PreOnline 1 -sys SystemName
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The preonline script is now configured to facilitate Enqueue server behavior. You
can view the logs in the VCS engine log, engine_A.log.
Note: Once the PreOnline trigger is configured, you may see unexpected behavior
while manually switching or performing online operations on the Enqueue
Replication service group. This behavior is a result of the control logic within the
PreOnline trigger that protects the Enqueue lock table. For system maintenance,
if you prefer to perform manual operations on the service groups, you can do so
by disabling the PreOnline trigger as follows:
C:\> hagrp -modify service_group PreOnline 0
For VCS 5.1 and later
C:\> hagrp -modify service_group PreOnline 0 -sys SystemName
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Troubleshooting the agent
for SAP NetWeaver
This chapter includes the following topics:
■

Using correct software and operating system versions

■

Meeting prerequisites

■

Configuring SAP server resources

■

Checks for an SAP Add-In system

■

Starting the SAP server outside a cluster server

■

Common Problems with Veritas agent for SAP server

■

Reviewing SAP NetWeaver agent log files

■

Using trace level logging

Using correct software and operating system versions
Ensure that no issues arise due to incorrect software and operating system
versions. For the correct versions of operating system and software to be installed
on the resource systems:
See “Supported software” on page 14.

Meeting prerequisites
Before installing the Veritas agent for SAP NetWeaver, double check that you
meet the prerequisite requirements. For a list of prerequisites:
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See “Before you install the agent for SAP NetWeaver” on page 77.

Configuring SAP server resources
Before using an SAP server resource, ensure that you configure the agent attributes
correctly. For more information,
See “Agent attributes for SAP NetWeaver” on page 83.

Checks for an SAP Add-In system
For an SAP Java Add-In instance, you must perform the following checks before
further investigations:
■

The SAP resources running the ABAP and Java Standalone Enqueue server
instances, must be in the same Service Group as the SAP Central instance.

■

The SAP resources running the ABAP and Java Enqueue Replication server
instances, must be in the same Service Group.

■

For the Standalone Enqueue server instances, the value of the InstType
attribute must not be ENQUEUE.
The values must be as follows:

■

■

For ABAP: AENQUEUE

■

For Java: JENQUEUE

For the Enqueue Replication server instances, the value of the InstType
attribute must not be ENQREP.
The values must be as follows:

■

■

For ABAP: AENQREP

■

For Java: JENQREP

Ensure the following:
■

The EnqSrvResName attribute of the ABAP Enqueue Replication server
instance is set to the VCS resource that is running the corresponding ABAP
Standalone Enqueue server instance.

■

The EnqSrvResName attribute of the Java Enqueue Replication server
instance is set to the VCS resource that is running the corresponding Java
Standalone Enqueue server instance.
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Starting the SAP server outside a cluster server
If you face problems while working with a resource, you must disable the resource
within the cluster framework. A disabled resource is not under the control of the
cluster framework, and so you can test the SAP server independent of the cluster
framework. Refer to the cluster documentation for information about disabling
a resource.
You can then restart the SAP server outside the cluster framework.
Note: Use the same parameters that the resource attributes define within the
cluster framework while restarting the resource outside the framework.
Follow one of these procedures to restart the SAP resource outside the framework.
To restart the SAP instance outside the framework using SAP MMC

1

Log in to the system as a sapsidadm user.

2

Use the SAP Microsoft Management Console (MMC) to start the SAP instance.
Ensure that the SAP instance starts successfully. Then attempt to start the
instance inside the cluster framework.

To restart the SAP instance outside the framework from the command prompt

1

Start the SAP Windows service for the SAPSAPSID_xx instance.

2

Use the startsap.exe utility to start the SAP instance:
startsap.exe name=SAPSID nr=InstID
sapdiahost=virtual_hostname

Common Problems with Veritas agent for SAP server
This section describes some problems that you may face while working with the
Veritas Agent for SAP NetWeaver in a VCS environment.

Unable to install the Veritas Agent for SAP NetWeaver
If you are not able to install the Veritas Agent for SAP NetWeaver, check to see
if previous versions of the agent are present in the system. If present, remove the
older agents and attempt to install the agent again.
Also, ensure that you go through the prerequisites before installing SAP
NetWeaver.
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See “Before you install the agent for SAP NetWeaver” on page 77.

Agent installation terminates with an error
If the installation process terminates with the error "The InstallScript engine on
this machine is older than the version required to run this setup", install the
InstallShield driver 10 or later and begin with the installation process again.

Unable to see an entry in the SAP MMC for an SAP instance
If you cannot see any entry for an SAP instance in the SAP MMC, you must
re-register the SAP services.
To re-register the SAP services

1

At the command prompt, go to the %windir%\SapCluster directory.

2

Run the sapstartsrv.exe command.

3

In the SAP Service Install/Uninstall dialog box, select Register COM
Typelibrary Only in the Operation field.
You must re-register the SAP services as described here whenever a change
in the SAP service registration occurs.

The agent for SAP server fails to bring online an SAP instance resource
through VCS
Attempt to start the SAP resource outside the VCS environment to ensure that
the resource is working properly.
See “Starting the SAP server outside a cluster server” on page 105.
You can also view the log files to further diagnose the problem.
See “Reviewing SAP NetWeaver agent log files” on page 110.

Unable to connect: DB connection failed
Ensure that the database is up and running successfully. If the database is not
functional, start the database. If applicable, start the client also. Then attempt to
reconnect.
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SAP instance does not come online, and the startsap.exe command
exits with exit code -1
Check the SAP MMC to ensure that the entry for this SAP instance is present. If
the entry is not present, add the SAP instance in the SAP MMC.
See “Unable to see an entry in the SAP MMC for an SAP instance” on page 106.
Then attempt to bring the SAP instance online.

In case of an Enqueue server failure, the Enqueue server instance fails
to take over the lock table from the Enqueue Replication server instance
If the Enqueue Replication server instance does not recognize the correct Enqueue
server instance, this problem may occur. Ensure that the value of InstID passed
to the Enqueue Replication server process, enrepserver.exe in the start profile,
belongs to the correct Enqueue server instance.

The ensmon.exe command returns exit code 4 for a Enqueue server
instance
If the Enqueue Replication server is not configured or is not online, this problem
occurs. Ensure that if the Enqueue Replication server is configured, the instance
is online.
If the Enqueue Replication server instance is not configured, disable the replication
parameter in the Instance profile of the Enqueue server instance:
enque/server/replication = false

The return code of the ensmon.exe command is 8 for an Enqueue
Replication server instance
The return code indicates that the Enqueue server instance is down. When the
Enqueue server instance fails, the ensmon.exe command returns this code when
the instance is switching over to the Enqueue Replication server instance to take
over the instate lock table.
Check the state of the Enqueue server instance.

Enqueue Replication server does not terminate after enqueue failover
This problem occurs due to a race condition between the Enqueue and the
Replication servers. To resolve the problem, make sure that your enrepserver.exe
is at the following patch level or a level later to it.
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7.00: 98
6.40: 171

For more information refer to, SAP Note 1018968

The Standalone Enqueue server instance does not fail over to the
correct Enqueue Replication server instance
This problem occurs if the preonline script is not configured properly. To configure
the preonline script:
See “Configuring the VCS preonline trigger” on page 98.
This problem also occurs if the InstType attribute is not set properly. Ensure that
the values of this attribute matches correctly.
Table 6-1 shows the values for InstType attribute.
Table 6-1

Values for InstType attribute

Value of InstType for a Standalone
Enqueue server instance

Corresponding value of InstType for an
Enqueue Replication server instance

ENQUEUE

ENQREP

AENQUEUE

AENQREP

JENQUEUE

JENQREP

If the Enqueue Replication server instance faults, the instance is failing
over to the node on which the Standalone Enqueue server instance is
online
Whenever an Enqueue Replication server instance faults, it must never fail over
to the node on which the corresponding Standalone Enqueue server instance is
online. This problem occurs if the preonline script is not configured properly to
take care of this failover behavior. To correctly configure the preonline script:
See “Configuring the VCS preonline trigger” on page 98.
This problem may also occur if the InstType attribute for both the server instances
do not match correctly. Ensure that the values match correctly.
Table 6-2 shows the values for InstType attribute.
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Table 6-2

Matching values for InstType attribute

Value of InstType for a Enqueue
Replication server instance

Corresponding value of InstType for a
Standalone Enqueue server instance

ENQREP

ENQUEUE

AENQREP

AENQUEUE

JENQREP

JENQUEUE

In case of a resource fault, the Service Group does not fail over
If the resource is not set to critical, the Service Group may not fail over. To resolve
the issue, set the resource to critical.

Unable to uninstall an older or current version of the Veritas Agent for
SAP NetWeaver
If you are attempting to uninstall an existing Veritas Agent for SAP NetWeaver,
ensure that you remove all configured SAP resources, before proceeding to remove
the agent.
See “Removing the VCS agent for SAP NetWeaver” on page 79.

Agent fails to start after installation
Ensure that you have installed Visual Studio 8 redistributable for Visual studio
runtime on your system. Since the agent is compiled with Microsoft.VC80.CRT
version='8.0.50727.762', it fails to start if Visual Studio 8 redistributable is not
installed.
To verify if Visual Studio 8 redistributable is installed, access <system
drive>:\WINDOWS\WinSxS. If a folder similar to
<arch>_Microsoft.VC80.CRT_<random_number>_8.0.50727.762_<random_number>

exists, it confirms that the required redistributable is installed.
For example,
amd64_Microsoft.VC80.CRT_1fc8b3b9a1e18e3b_8.0.50727.762_x-ww_9d1c6ce0

In case if the redistributable is not installed, download the Visual studio
re-distributables for VS 2005 SP1 with version VC80.CRT_8.0.50727.762 from
microsoft site at the following locations:
For x64 (amd64)
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http://www.microsoft.com/downloads/details.aspx?
familyid=EB4EBE2D-33C0-4A47-9DD4-B9A6D7BD44DA&displaylang=en
For IA64 (Intel64)
http://www.microsoft.com/downloads/details.aspx?
familyid=747AAD7C-5D6B-4432-8186-85DF93DD51A9&displaylang=en

Reviewing SAP NetWeaver agent log files
If you are facing problems while using the Veritas agent for SAP NetWeaver or
an SAP server instance, refer to the following sections to access the relevant files
for information about the issue.

Using SAP instance log files
In case of problems while using the Veritas Agent for SAP NetWeaver, you can
access the SAP instance log files for more information. These log files are located
in the drive:\usr\sap\SAPSID\InstName\work directory.

Using SAP log files
If an SAP server is facing problems, you can access the agent log files to further
diagnose the problem. The log file is drive:\Program Files\VERITAS\Cluster
Server\log\SAPNW04_A.txt.

Using trace level logging
The ResLogLevel attribute controls the level of logging that is written in a VCS
log file for each SAP server resource. You can set this attribute to TRACE, which
enables very detailed and verbose logging.
If you set ResLogLevel to TRACE, a very high volume of messages is produced.
Symantec recommends that you must localize the ResLogLevel attribute for
particular resource only.
Note: You may consider to temporarily increase the timeout values for SAPNW04
for debugging purposes. After the debugging process is complete, you can revert
to the original timeout values.
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To localize ResLogLevel attribute for a resource

1

Identify the resource for which you want to enable detailed logging.

2

At the command prompt, localize the ResLogLevel attribute for the identified
resource:
hares -local Resource_Name ResLogLevel

3

Set the ResLogLevel attribute to TRACE for the identified resource:
hares -modify Resource_Name ResLogLevel TRACE -sys SysA

4

Test the identified resource. The operation reproduces the problem that you
are attempting to diagnose.

5

Set the ResLogLevel attribute back to INFO for the identified resource:
hares -modify Resource_Name ResLogLevel INFO -sys SysA

6

Review the contents of the VCS engine output log file.
You can also use the Java GUI to localize the ResLogLevel attribute. For more
information, refer to the VCS documentation.
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Appendix

A

Sample Configurations
This appendix includes the following topics:
■

About the sample configuration for the agent for SAP NetWeaver

■

Sample agent type definition

■

Sample resource configuration

■

Sample sevice group configuration for ABAP and Java architectures

■

Sample service group configuration for Add-in (ABAP + Java ) installation type

■

Sample service group configurations for SAP system on Windows Server 2008

■

Sample service group dependency for SAP NetWeaver

About the sample configuration for the agent for SAP
NetWeaver
The sample configuration depicts the resource types, resources, and resource
dependencies within the Service Group. Review these dependencies carefully
before configuring the agent for SAP NetWeaver. For more information about
these resource types, see the Veritas Cluster Server Bundled Agents Reference
Guide.

Sample agent type definition
The sample agent type definition for SAP NetWeaver is as follows:
type SAPNW04 (
static i18nstr ArgList[] = { SAPSID, SecondLevelMonitor,
EPProgramTimeout, SAPHome, SAPMonHome, SAPHost, ProcMon,
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SAPServiceUser, SAPAdminDomain, SAPAdmin, SAPAdminPassword,
ResLogLevel, InstType, InstName, InstProfile, EnqSrvResName,
MonitorProgram }
str SAPSID
int SecondLevelMonitor
int EPProgramTimeout = 10
str SAPHome
str SAPMonHome
str SAPHost
str ProcMon[]
str SAPServiceUser
str SAPAdminDomain
str SAPAdmin
str SAPAdminPassword
str ResLogLevel = INFO
str InstType = CENTRAL
str InstName
str InstProfile
str EnqSrvResName
str MonitorProgram
)

Sample resource configuration
For some values of the InstType attribute, corresponding sample main.cf files are
as follows.

InstType is equal to ENQUEUE
The sample main.cf file is as follows.
SAPNW04 SAPEC4ASCS_sap
(
Critical = 0
SAPSID = EC4
SecondLevelMonitor = 5
SAPHome = "C:\\usr\\sap\\EC4\\ASCS10\\exe"
SAPMonHome = "C:\\usr\\sap\\EC4\\ASCS10\\exe"
SAPHost = SAPEC4ASCS
ProcMon = { "enserver.exe", "msg_server.exe" }
SAPServiceUser = SAPServiceEC4
SAPAdminDomain = ISV-DOMAIN
SAPAdmin = ec4adm
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SAPAdminPassword = IWOuLWlQIoJOkOL
InstType = AENQUEUE
InstName = ASCS10
InstProfile =
"C:\\usr\\sap\\EC4\\SYS\\profile\\EC4_ASCS10_SAPEC4ASCS"
)

InstType is equal to CENTRAL
The sample main.cf file is as follows.
SAPNW04 SAPEC4CI_sap
(
Critical = 0
SAPSID = EC4
SAPHome = "C:\\usr\\sap\\EC4\\DVBGS12\\exe"
SAPMonHome = "C:\\usr\\sap\\EC4\\sapinfo\\rfcsdk\\bin"
SAPHost = SAPEC4CI
ProcMon = { "disp+work.exe" }
SAPServiceUser = SAPServiceEC4
SAPAdminDomain = ISV-DOMAIN
SAPAdmin = ec4adm
SAPAdminPassword = BPHnEPeJBhCHdHE
InstName = DVBGS12
InstType = CENTRAL
InstProfile = "\\\\SAPEC4ASCS\\sapmnt\\EC4\\SYS\\profile\
\EC4_DVBGS12_SAPEC4CI"
)

InstType is equal to ENQREP
The sample main.cf file is as follows.
SAPNW04 SAPEC4REP_sap
(
Critical = 0
SAPSID = EC4
SecondLevelMonitor = 1
SAPHome = "C:\\usr\\sap\\EC4\\REP11\\exe"
SAPMonHome = "C:\\usr\\sap\\EC4\\REP11\\exe"
SAPHost = SAPEC4REP
ProcMon = { "enrepserver.exe" }
SAPServiceUser = SAPServiceEC4
SAPAdminDomain = ISV-DOMAIN
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SAPAdmin = ec4adm
SAPAdminPassword = HVNtKVkPHnINjNK
InstType = AENQREP
InstName = REP11
InstProfile =
"\\\\SAPEC4ASCS\\sapmnt\\EC4\\SYS\\profile\\EC4_REP11_SAPEC4REP"
EnqSrvResName = SAPEC4ASCS_sap
)

InstType is equal to DIALOG
The sample main.cf file is as follows:
SAPNW04 SAPEC4DI_sap
(
Critical = 0
SAPSID = EC4
SAPHome = "C:\\usr\\sap\\EC4\\D13\\exe"
SAPMonHome = "C:\\usr\\sap\\EC4\\sapinfo\\rfcsdk\\bin"
SAPHost = SAPEC4DI
ProcMon = { "disp+work.exe" }
SAPServiceUser = SAPServiceEC4
SAPAdminDomain = ISV-DOMAIN
SAPAdmin = ec4adm
SAPAdminPassword = BPHnEPeJBhCHdHE
InstName = D13
InstType = DIALOG
InstProfile = "\\\\SAPEC4ASCS\\sapmnt\\EC4\\SYS\
\profile\\EC4_D13_SAPEC4DI"
)

Sample sevice group configuration for ABAP and Java
architectures
The service group configuration in a cluster depends on some common
characteristics that must be a part of the configuration design.
These characteristics include the following:
■

The SAP Central instance server or the Enqueue server must be dependent on
the database server.

■

Each SAP instance (Central, Dialog, Enqueue, and Enqueue Replication) should
have a separate virtual IP address assigned to facilitate network transparency.
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■

Each SAP instance (Central, Dialog, Enqueue and Enqueue Replication) should
be placed on shared disk to facilitate cluster node transparency.

■

Common file systems to include the profile, global and transaction file systems
should be managed from one or more shared disk objects. These systems must
be available to the SAP instance via UNC path with SAPGLOBALHOST.

Figure A-1 shows a sample service group configuration for Enqueue (Central
Service) instance.
Figure A-1

Service group configuration for Enqueue instance

SAP70_ERPASCS_sap
SAPNW04

Lanman
MountV
SAP70_ERPASCS_lanman
SAP70_ERPASCS_mnt

IP

VMDg
SAP70_ERPASCS_ip

SAP70_ERPASCS_vmdg

NIC
SAP70_ERPASCS_nic

Figure A-2 shows a sample service group configuration for Dialog instance
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Figure A-2

Service group configuration for Dialog instance
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Figure A-3 shows a sample service group configuration for Central instance.
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Figure A-3

Service group configuration for Central instance
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MountV
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Figure A-4 shows a sample service group configuration for Enqueue Replication
Server instance.
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Figure A-4

Service group configuration for Enqueue Replication Server instance
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Sample service group configuration for Add-in (ABAP
+ Java ) installation type
The characteristics of the configuration design for this installation type are as
follows:
■

The Central instance server, and Java and ABAP Enqueue Server Service Group
must be globally dependent on the database server Service Group.

■

The Java and ABAP Enqueue servers and the Central instance optionally
configured in one Service Group.
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Note: Symantec recommends to configure the Enqueue Servers and Central
instance in separate service groups.

■

If Enqueue Servers are configured on different service groups, the ABAP and
Java Enqueue Replication servers must be configured in two different service
groups.

■

To facilitate the network transparency,
■

Each SAP server that hosts a Central or Dialog instance must have a
separate virtual IP address.

■

The ABAP and Java Enqueue Server, and the Central instance optionally
have the same Virtual IP address.
Note: Symantec recommends to have two different virtual IPs for Enqueue
Servers and Central instance.

■

The ABAP and Java Enqueue Replication servers must have different virtual
IP address, if they are configured in different service groups.

■

To facilitate cluster node transparency, each SAP server that hosts a Central,
Dialog, ABAP Enqueue, Java Enqueue, Java and ABAP Enqueue Replication
instances must be placed on shared disk.

■

Common file systems that include profile, global, and transaction file systems
must be managed from one or more shared disk objects. These systems must
be available to the SAP application through UNC path via SAPGLOBALHOST.

Figure A-5 shows a sample service group configuration for Enqueue (Central
Services) instances for Add-In
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Figure A-5

MountV

Enqueue (Central Services) instance for Add-In
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Figure A-6 shows a sample service group configuration for Enqueue Replication
instances for Add-In
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Figure A-6

Enqueue Replication instance for Add-In
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Sample service group configurations for SAP system
on Windows Server 2008
This section provides the sample service group configurations and resource
dependency diagrams for SAP systems on Windows Server 2008.

123

124

Sample Configurations
Sample service group configurations for SAP system on Windows Server 2008

Sample configuration for SAP Central Services Instances service group
for Add-In installation Usage Type
This section provides the VCS main.cf for SAP Central Services Instances service
group for Add-In installation Usage Type.
group SAP-PI3SCS (
SystemList = { SysA = 0, SysB = 1 }
)
FileShare SAP-PI3SCS_sapmnt_FS (
PathName = "\\usr\\sap"
ShareName = sapmnt
LanmanResName = SAP-PI3SCS_Lanman
MountResName = SAP-PI3SCS_H_MountV
UserPermissions = { "'SAP_LocalAdmin'" = FULL_CONTROL,
"'Administrators'" = FULL_CONTROL,
"'SYMCORP\\SAP_PI3_GlobalAdmin'" = FULL_CONTROL,
"'SAP_PI3_LocalAdmin'" = FULL_CONTROL }
)
IP SAP-PI3SCS_IP (
Address = "10.209.70.30"
SubNetMask = "255.255.252.0"
MACAddress = "00-15-17-63-45-92"
)
Lanman SAP-PI3SCS_Lanman (
VirtualName = sappi3scs
IPResName = SAP-PI3SCS_IP
)
MountV SAP-PI3ASCS_MountV (
MountPath = "I:\\usr\\sap\\PI3\\ASCS29"
VolumeName = PI3ASCS_vol
VMDGResName = SAP-PI3ASCS_VMDg
)
MountV SAP-PI3SCS_MountV (
MountPath = "I:\\usr\\sap\\PI3\\SCS30"
VolumeName = PI3SCS_vol
VMDGResName = SAP-PI3SCS_VMDg
)
MountV SAP-PI3SCS_I_MountV (
MountPath = "I:"
VolumeName = PI3SCS_I_vol
VMDGResName = SAP-PI3SCS_I_VMDg
)
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MountV SAP-PI3SYS_MountV (
MountPath = "I:\\usr\\sap\\PI3\\SYS"
VolumeName = PI3SYS_vol
VMDGResName = SAP-PI3SYS_VMDg
)
NIC SAP-PI3SCS_NIC (
MACAddress = "00-15-17-63-45-92"
)
SAPNW04 SAP-PI3ASCS_SAPNW04 (
SAPSID = PI3
SAPHome = "I:\\usr\\sap\\PI3\\ASCS29\\exe"
SAPMonHome = "I:\\usr\\sap\\PI3\\ASCS29\\exe"
SAPHost = sappi3scs
ProcMon = { "msg_server.exe", "enserver.exe" }
SAPServiceUser = SAPServicePI3
SAPAdminDomain = SYMCORP
SAPAdmin = pi3adm
SAPAdminPassword = AFkl41nmqdaou
InstType = ENQUEUE
InstName = ASCS29
InstProfile = "I:\\usr\\sap\\PI3\\SYS\\profile\\PI3_ASCS29_sappi3scs"
)
SAPNW04 SAP-PI3SCS_SAPNW04 (
SAPSID = PI3
SAPHome = "I:\\usr\\sap\\PI3\\SCS30\\exe"
SAPMonHome = "I:\\usr\\sap\\PI3\\SCS30\\exe"
SAPHost = sappi3scs
ProcMon = { "msg_server.exe", "enserver.exe" }
SAPServiceUser = SAPServicePI3
SAPAdminDomain = SYMCORP
SAPAdmin = pi3adm
SAPAdminPassword = AFkl41nmqdaou
InstType = ENQUEUE
InstName = SCS30
InstProfile = "I:\\usr\\sap\\PI3\\SYS\\profile\\PI3_SCS30_sappi3scs"
)
VMDg SAP-PI3SCS_I_VMDg (
DiskGroupName = PI3SCS_I_dg
)
VMDg SAP-PI3ASCS_VMDg (
DiskGroupName = PI3ASCS_dg
)
VMDg SAP-PI3SCS_VMDg (
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DiskGroupName = PI3SCS_dg
)
VMDg SAP-PI3SYS_VMDg (
DiskGroupName = PI3SYS_dg
)
SAP-PI3SCS_sapmnt_FS requires SAP-PI3SCS_Lanman
SAP-PI3SCS_sapmnt_FS requires SAP-PI3SCS_I_MountV
SAP-PI3SCS_IP requires SAP-PI3SCS_NIC
SAP-PI3SCS_Lanman requires SAP-PI3SCS_IP
SAP-PI3ASCS_MountV requires SAP-PI3SCS_I_MountV
SAP-PI3ASCS_MountV requires SAP-PI3ASCS_VMDg
SAP-PI3SCS_MountV requires SAP-PI3SCS_I_MountV
SAP-PI3SCS_MountV requires SAP-PI3SCS_VMDg
SAP-PI3SCS_I_MountV requires SAP-PI3SCS_I_VMDg
SAP-PI3SYS_MountV requires SAP-PI3SCS_I_MountV
SAP-PI3SYS_MountV requires SAP-PI3SYS_VMDg
SAP-PI3ASCS_SAPNW04 requires SAP-PI3SCS_sapmnt_FS
SAP-PI3ASCS_SAPNW04 requires SAP-PI3ASCS_MountV
SAP-PI3ASCS_SAPNW04 requires SAP-PI3SYS_MountV
SAP-PI3SCS_SAPNW04 requires SAP-PI3SCS_sapmnt_FS
SAP-PI3SCS_SAPNW04 requires SAP-PI3SCS_MountV
SAP-PI3SCS_SAPNW04 requires SAP-PI3SYS_MountV
resource dependency tree
group SAP-PI3SCS
{
SAPNW04 SAP-PI3ASCS_SAPNW04
{
FileShare SAP-PI3SCS_sapmnt_FS
{
Lanman SAP-PI3SCS_Lanman
{
IP SAP-PI3SCS_IP
{
NIC SAP-PI3SCS_NIC
}
}
MountV SAP-PI3SCS_I_MountV
{
VMDg SAP-PI3SCS_I_VMDg
}
}
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MountV SAP-PI3ASCS_MountV
{
MountV SAP-PI3SCS_I_MountV
{
VMDg SAP-PI3SCS_I_VMDg
}
VMDg SAP-PI3ASCS_VMDg
}
MountV SAP-PI3SYS_MountV
{
MountV SAP-PI3SCS_I_MountV
{
VMDg SAP-PI3SCS_I_VMDg
}
VMDg SAP-PI3SYS_VMDg
}
}
SAPNW04 SAP-PI3SCS_SAPNW04
{
FileShare SAP-PI3SCS_sapmnt_FS
{
Lanman SAP-PI3SCS_Lanman
{
IP SAP-PI3SCS_IP
{
NIC SAP-PI3SCS_NIC
}
}
MountV SAP-PI3SCS_I_MountV
{
VMDg SAP-PI3SCS_I_VMDg
}
}
MountV SAP-PI3SCS_MountV
{
MountV SAP-PI3SCS_I_MountV
{
VMDg SAP-PI3SCS_I_VMDg
}
VMDg SAP-PI3SCS_VMDg
}
MountV SAP-PI3SYS_MountV
{
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MountV SAP-PI3SCS_I_MountV
{
VMDg SAP-PI3SCS_I_VMDg
}
VMDg SAP-PI3SYS_VMDg
}
}
}

Sample resource dependency for SAP Central Services Instances service
group for Add-In installation usage type
Figure A-7 shows the sample resource dependency diagram for SAP Central
Services Instances service group for Add-In installation Usage Type on a Windows
2008 Server.
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Sample resource dependency diagram for SAP Central Services
Instances service group for Add-In installation Usage Type on a
Windows 2008 Server

Figure A-7
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Sample configuration for SAP Enqueue Replication Server Instances
service group for Add-In installation Usage Type
group SAP-PI3ERS (
SystemList = { SysA = 0, SysB = 1 }
)
IP SAP-PI3ERS_IP (
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Address = "10.209.70.31"
SubNetMask = "255.255.252.0"
MACAddress = "00-15-17-63-45-92"
)
Lanman SAP-PI3ERS_Lanman (
VirtualName = sappi3ers
IPResName = SAP-PI3ERS_IP
)
MountV SAP-PI3AERS_MountV (
MountPath = "C:\\usr\\sap\\PI3\\ERS31"
VolumeName = PI3AERS_vol
VMDGResName = SAP-PI3AERS_VMDg
)
MountV SAP-PI3ERS_MountV (
MountPath = "C:\\usr\\sap\\PI3\\ERS32"
VolumeName = PI3ERS_vol
VMDGResName = SAP-PI3ERS_VMDg
)
NIC SAP-PI3ERS_NIC (
MACAddress = "00-15-17-63-45-92"
)
SAPNW04 SAP-PI3AERS_SAPNW04 (
SAPSID = PI3
SAPHome = "C:\\usr\\sap\\PI3\\ERS31\\exe"
SAPMonHome = "C:\\usr\\sap\\PI3\\ERS31\\exe"
SAPHost = sappi3ers
ProcMon = { "enrepserver.exe" }
SAPServiceUser = SAPServicePI3
SAPAdminDomain = SYMCORP
SAPAdmin = pi3adm
SAPAdminPassword = AFkl41nmqdaou
InstType = ENQREP
InstName = ERS31
InstProfile = "\\\\sappi3scs\\sapmnt\\PI3\\SYS\\
profile\\PI3_ERS31_sappi3ers"
EnqSrvResName = SAP-PI3ASCS_SAPNW04
)
SAPNW04 SAP-PI3ERS_SAPNW04 (
SAPSID = PI3
SAPHome = "C:\\usr\\sap\\PI3\\ERS32\\exe"
SAPMonHome = "C:\\usr\\sap\\PI3\\ERS32\\exe"
SAPHost = sappi3ers
ProcMon = { "enrepserver.exe" }
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SAPServiceUser = SAPServicePI3
SAPAdminDomain = SYMCORP
SAPAdmin = pi3adm
SAPAdminPassword = AFkl41nmqdaou
InstType = ENQREP
InstName = ERS32
InstProfile = "\\\\sappi3scs\\sapmnt\\PI3\\SYS\\
profile\\PI3_ERS32_sappi3ers"
EnqSrvResName = SAP-PI3SCS_SAPNW04
)
VMDg SAP-PI3AERS_VMDg (
DiskGroupName = PI3AERS_dg
)
VMDg SAP-PI3ERS_VMDg (
DiskGroupName = PI3ERS_dg
)
SAP-PI3ERS_IP requires SAP-PI3ERS_NIC
SAP-PI3ERS_Lanman requires SAP-PI3ERS_IP
SAP-PI3AERS_MountV requires SAP-PI3AERS_VMDg
SAP-PI3ERS_MountV requires SAP-PI3ERS_VMDg
SAP-PI3AERS_SAPNW04 requires SAP-PI3AERS_MountV
SAP-PI3AERS_SAPNW04 requires SAP-PI3ERS_Lanman
SAP-PI3ERS_SAPNW04 requires SAP-PI3ERS_MountV
SAP-PI3ERS_SAPNW04 requires SAP-PI3ERS_Lanman
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//
//

resource dependency tree
group SAP-PI3ERS
{
SAPNW04 SAP-PI3AERS_SAPNW04
{
MountV SAP-PI3AERS_MountV
{
VMDg SAP-PI3AERS_VMDg
}
Lanman SAP-PI3ERS_Lanman
{
IP SAP-PI3ERS_IP
{
NIC SAP-PI3ERS_NIC
}
}
}
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// SAPNW04 SAP-PI3ERS_SAPNW04
//
{
//
MountV SAP-PI3ERS_MountV
//
{
//
VMDg SAP-PI3ERS_VMDg
//
}
//
Lanman SAP-PI3ERS_Lanman
//
{
//
IP SAP-PI3ERS_IP
//
{
//
NIC SAP-PI3ERS_NIC
//
}
//
}
//
}
// }

Sample resource dependency for SAP Enqueue Replication Server
Instances service group for Add-In installation Usage Type
Figure A-8 shows the sample resource group dependency for SAP Enqueue
Replication Server Instances service group for Add-In installation Usage Type.
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Sample resource group dependency for SAP Enqueue Replication
Server Instances service group for Add-In installation Usage Type
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Sample service group dependency for SAP NetWeaver
Figure A-9 shows the sample service group dependency for SAP NetWeaver
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Sample service group dependency

Figure A-9
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Appendix

B

Changes introduced in Past
releases
This appendix includes the following topics:
■

Changes introduced in the past releases

Changes introduced in the past releases
The changes introduced in the past releases of the agent for SAP NetWeaver are
as follows:
■

Added support for NETBIOS domain names (old domains) for SAPAdminDomain
attribute.

■

Package is modified to install both SAPNW04 and SAPWebAS agents.

■

Added support for Windows Server 2008 (x64)

■

Added support for SFWHA 5.1 SP1

■

Added support for Secure cluster

■

Support for different passwords for SAPServiceUser and SAPAdmin users.

■

Added support for VCS 5.1 on Microsoft Windows Server 2003 (x64) and IA64

■

Added support for Instance IDs 97, 98 and 99

■

Added support for local system user accounts for SAPAdmin and
SAPServiceUser attributes
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